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LICENSE AGREEMENT 
 

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING 

THIS SOFTWARE PACKAGE. INSTALLING THE SOFWARE PACKAGE INDICATES YOUR ACCEPTANCE 

TO THE CONTAINED TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD 

PROMPTLY RETURN THIS PACKAGE, IN REUSABLE CONDITION, FOR A FULL REFUND OF THE 

PURCHASED PRICE. 

 

SIMPLICITY SOFTWARE TECHNOLOGIES provides single copies of this software 

("computer program") and licenses its use. You are responsible for the selection 

of the program and the installation, use and results obtained.  

 

You may not sub - license, assign or transfe r the license or the program without 

expressed permission from SIMPLICITY SOFTWARE TECHNOLOGIES.  

 

You further agree that this is the complete and exclusive statement of 

agreement, oral or written, and any other communications between us relating to 

the sub ject matter of this Agreement.  

 

SIMPLICITY SOFTWARE TECHNOLOGIES licenses this software as either a single user 

version or as a site license, unlimited users version. This is done through the 

activation file that is supplied by SIMPLICITY SOFTWARE TECHNOLO GIES. Once the 

software is activated, this licensing condition is also indicated in the About 

dialog screen found within the main section of the application.  

 

For Single User licenses, THIS LICENSE permits you to:  

 

1.  Use the program on a maximum of one c omputer or workstation at a single 

facility.  

2.  Copy the program onto a hard drive or other media for use on a maximum of 

one computer or workstation located at the same facility.  

3.  Modify the program and/or merge it into another program for use on the 

maximum of one computer or workstation.  

4.  Transfer the program and license to another party if the other party agrees 

to accept the terms and conditions of this Agreement. If you transfer the 

program, you must at the same time transfer all copies of the original single 

copy to the same party or destroy any copies not transferred, and  

5.  Copy the databases used by this program to single computer or to a network 

drive to be shared by no more than 1 computer or workstation.  

 

For Site licenses, THIS LICENSE permits you to:  

 

1.  Use the program on as many computers or workstations as needed, at a single 

facility.  

2.  Copy the program onto a hard drive or other media for use on as many 

computers or workstations as needed, located at the same facility.  

3.  Modify the program and/or merge it into another program for use at a single 

facility.  

4.  Transfer the program and license to another party if the other party agrees 

to accept the terms and conditions of this Agreement. If you transfer the 

program, you mus t at the same time transfer all copies of the original single 

copy to the same party or destroy any copies not transferred, and  

5.  Copy the databases used by this program to single computer or to a network 

drive to be shared by a single facility.  
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The condit ions above also apply to any portions of the program contained or 

merged in other programs. You must reproduce and include the copyright notice 

on any copy, modification, or portion merged into another program.  

 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER T HE PROGRAM OR ANY COPY, MODIFICATION, 

OR MERGED PORTION IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED FOR IN THIS 

LICENSE. IF YOU TRANSFER ANY COPY, MODIFICATION, OR MERGED PORTION OF THIS 

PROGRAM TO ANOTHER PARTY, THIS LICENSE IS AUTOMATICALLY TERMINA TED.  

 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE ACTIVATION FILE SUPPLIED BY 

SIMPLCITY SOFTWARE IN ANY WAY WHATSOEVER. You may however make a single copy of 

the file for backup purposes only.  

 

This license is effective until terminated. You may termina te it at any time by 

destroying the program along with all copies, modifications and merged portions 

in any form. It will also be terminated upon conditions set forth elsewhere in 

this Agreement.  

 

THIS PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KI ND, EITHER EXPRESSED 

OR IMPLIED. THE ENTIRE RISK AS TO THE PERFORMANCE OF THE PROGRAM IS WITH YOU, 

IF THE PROGRAM PROVE DEFECTIVE. YOU ASSUME THE ENTIRE COST OF ALL NECESSARY 

SERVICING, REPAIR, OR CORRECTION. SOME COUNTRIES DO NOT ALLOW EXCLUSION OF 

IMPLIE D WARRANTITES, SO THE ABOVE EXCLUSION MAY NOT APPLY.  

 

SIMPLICITY SOFTWARE TECHNOLOGIES does not warrant the function contained in the 

program will meet your requirements or the operation of the program will be 

uninterrupted or error - free. However, SIMPLICI TY SOFTWARE TECHNOLOGIES does 

warrant that the media on which the program is furnished is to be free of 

defects in materials and workmanship under normal use for 180 days from the 

date of shipment.  

 

SIMPLICITY SOFTWARE TECHNOLOGIES ENTIRE LIABILITY AND YOU R EXCLUSIVE REMEDY FOR 

THE PROGRAM SHALL BE THE REPLACEMENT OF ANY DISKETTE OR CD- ROM FOUND TO BE 

DEFECTIVE. IN NO EVENT WILL SIMPLICITY SOFTWARE TECHNOLOGIES BE LIABLE FOR 

DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR 

CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABLILTY TO USE SUCH SOFTWARE. 

SOME COUNTRIES DO NOT ALLOW EXCLUSION OF IMPLIED WARRANTITES, SO THE ABOVE 

EXCLUSION MAY NOT APPLY. 

 

IF THIS SOFTWARE IS INSTALLED AS A "TRIAL VERSION", IT SHOULD EITHER BE 

REGISTERED WITH SIMPLICITY SOFTWARE TECHNOLOGIES, OR REMOVE FROM ALL COMPUTERS 

WITHIN FOURTY- FIVE DAYS OF INITIAL INSTALLATION.  

 

THIS LICENSE CAN ONLY BE MODIFIED BY AN AUTHORIZED REPRESENTATIVE OF SIMPLICITY 

SOFTWARE TECHNOLOGIES, AND MUST BE SIGNED BY AN AUTHORIZED REPRESENTATIVE. 
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'ÅÔÔÉÎÇ 3ÔÁÒÔÅÄ 

The procedures presented herein assume that the purchaser of this product has basic computer skills 

and has used the Windows environment in the past. Many of the functions such as file open, file save, 

run option and the like can change depending on the operating environment the application is executed 

ƛƴΦ Lƴ ǎǳŎƘ ŎŀǎŜǎ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ǳǎŜǊΩǎ Ƴŀƴǳŀƭ ŦƻǊ ǘƘŀǘ ŜƴǾƛǊƻƴƳŜƴǘ όǎǳǇǇƭƛŜŘ ōȅ ǘƘŀǘ ǾŜƴŘƻǊύΦ 

Administrator Rights  
Throughout the documentation we talk about logging into the system as a user with Admin or 

Administrator rights. These rights are setup with user accounts; please refer to the Security, Databases 

and Utility Modules chapter for more information on this subject. 

Please note that if password protection has not been turned on, all users 

effectively have Administrator rights. 

Installing t he Application  
Maintenance Coordinator can be supplied to you a few different ways. We can send you a compact disk 

(CD), DVD, and the software can be downloaded. 

IMPORTAND NOTE: If you already have a demo of the software installed, re-

installation may not be required. Just activate the demo. 

To install Maintenance Coordinator onto your computer: 

FROM DOWNLOAD 

¶ Create a directory or folder on your local hard drive to download the file to. 

¶ From the web-site, click on the appropriate download link to begin the download. 

¶ Save the file to the directory you created above. 

¶ Run the downloaded application to start the installation process. 

¶ Follow on screen instructions. 

FROM CD OR DVD 

¶ Insert the CD or DVD into an available reader. If your computer is setup correctly, the program 

should run automatically. 

¶ LŦ ǘƘŜ ǇǊƻƎǊŀƳ ŘƻŜǎƴΩǘ ǎǘŀǊǘ ŀǳǘƻƳŀǘƛŎŀƭƭȅΥ 

o Click the Start menu and choose the Run option. 

o Click the Browse button and navigate to your media reader. 

o Select the Setup.exe application on the root directory of the CD/DVD. 

o Click Open. 
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o Click OK. 

¶ Click the Install Products option. 

¶ Click on the option that best describes the application you want to install. 

¶ Follow on screen instructions. 

Installing for Network Use  
Please note that a Network/Site License must have been purchased to use the routines outlined in this 

section. If such a license has not been purchased then your databases must reside on the local C: drive. 

To install the program for use on a network, please follow these steps: 

¶ Install the program on each client computer as you would as if it was a single user setup 

(previous section).  

¶ Activate the software on each computer it's installed to. If not activated, network paths will not 

be allowed. 

¶ Copy the databases used by the program to a sharable network drive. These are the files with an 

.mdf file extension. 

¶ !ƭǎƻ ŎƻǇȅ ǘƘŜ ŘŀǘŀōŀǎŜΩǎ ŀǎǎƻŎƛŀǘŜŘ ǘǊŀƴǎŀŎǘƛƻƴ ƭƻƎ ŦƛƭŜΦ ¢Ƙƛǎ ŦƛƭŜ ǿƛƭƭ ƘŀǾŜ ŀƴ ŜȄǘŜƴǎƛƻƴ ƻŦ ΦƭŘŦΣ 

and shares most of the same name as the database fƛƭŜ ƛǘΩǎ ŀǎǎƻŎƛŀǘŜŘ ǿƛǘƘΦ 

¶ Set up the database connections to use the copied databases.  

Setting up Database Connections 
By default, the databases used by the Maintenance Coordinator system are installed to the 

Documents\ Maintenance Coordinator folder. It is highly recommended that you leave a set of these 

databases in this location. However, there are occasions when you want them to reside in other 

locations, such as on a network drive or share. When moving the databases, we recommend copying the 

databases to the new location. 

Please note that a Network/Site License must have been purchased to network 

the databases. 

To setup your database connections: 

¶ Log in to the program as a user with administrator rights. 
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¶ From the main start menu, open the Admin drop down menu and select the Setup Database 

Connections option. 

 
¶ From the invoked Connections Settings dialog, move to the Main Database group and click on 

the Set Connection button.  
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¶ This will invoke the SQL Connection dialog screen as shown in the following illustration: 

 

¶ Move to the Sever name drop down box and select the name of your instance of the SQL server 
ȅƻǳΩǊŜ ǳǎƛƴƎΦ LŦ ǘƘŜ ǎŜǊǾŜǊ ƛǎ ƴƻǘ ƭƛǎǘŜŘΣ ǘǊȅ ŎƭƛŎƪƛƴƎ ƻƴ ǘƘŜ Refresh button. 

¶ Move to the Log on to the server group and setup your log on authentication information.  
o Using SQL Express - If you are using the Express database engines as supplied by us, 
ȅƻǳΩƭƭ ǇǊƻōŀōƛƭƛǘȅ ǿŀƴǘ ǘƻ ŎƘŜŎƪ ǘƘŜ Use Windows Authentication option.  

o SQL Server - If you are connecting to full blown SQL Server then complete the SQL 
Server Authentication information. 
Á Check the Use SQL Server Authentication option. 

¶ Fill in the User Name and Password fields. 

¶ Next move to the Connect to a database group to connect to the actual database. 
o SQL Server: 

Á Check the Select or enter a database name option. 
Á Move to the drop down found here and either select or enter the name of the 

database you are connecting to. 
o SQL Express: (Attached database file) 

Á Check the Attach a database file option. 
Á Either use the Browse button here to select the database file, or type in the full 

path to the database (mdf) file in the space provided. 

¶ Test Connection ς Move to and click on the Test Connection button to ensure you have a good 
connect. If it fails, you may want to click on the Advanced button to further define you 
connection properties. 

¶ Click on the OK button. 

¶ Repeat the above steps for the remaining databases that require setup. 
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Brief Descript ion of the Databases 
¶ Main Database - This database holds the main information or tables dealing with Maintenance 

Coordinator. Some of the included tables are HR (Employees), Inventory and Parts, Contacts and 

Vendors, Maintenance Documents, Main Programs settings and User Accounts. 

¶ Work Orders Database ς This database hold everything dealing with work orders and PMs. This 

also includes work instructions and time tracking information. 

¶ Purchasing and Receiving Database ς This database maintain information for Purchasing and 

Receiving support, purchase orders, purchase requisitions and blanket purchase orders. 

¶ Personal Manager Database ς This database maintains information on personal items. Personal 

Log, Personal Scheduler, Personal Contacts and Journal information. 

¶ Professional Add-Ons Database ς This database supports some of the add-on features and their 

data storage. Currently supported are Issues and Safety Management information. 

Running the Program  
Once the program has been successfully installed onto your computer, you can now begin using it by 

following the next instructions: 

¶ Click the Start button for Windows XP or later. 

¶ Click SST then the Maintenance Coordinator option to start the program. 

OR 

¶ Click the Maintenance Coordinator icon on your desktop. 

Activating or Validating the Software  
The primary way the software is validated or activated is through email, the general procedure for this is 

as outlined next: 

To activate the application from an email message (Outlook example): 

1. Open the Email in Microsoft Outlook. 

2. Open the File menu and select the Save Attachments option. 

3. The Save Attachment dialog opens. 

4. Browse to the following directory: 

     Documents/Maintenance Coordinator 

5. Click on the Save button, replacing any existing files. 

6. Run the program and it should turn into a full working version. 

 

Validating from Demo Mode  
To unlock a demo version into a full working version please follow these steps: 
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¶ The application must first be purchased and an activation file supplied by Simplicity Software 

Technologies Inc. The name of the activation file is: MC_Act.lic. 

¶ Run the application in your normal manner. 

 
¶ From the Choose Demo Mode screen, move to and click the Activate Software button. 

¶ From this common Open file type dialog, browse to where you saved the activation file as 

supplied from Simplicity Software Technologies. The file name should be: MC_Act.lic 

¶ Select the file and click Open. 

¶ The program should now be a full working version.  

Validating from within the Application  
To activate the software from within the application, please follow these steps: 

Note this procedure can also upgrade the application with newly purchased 

features. 

The application must first be purchased and an activation file supplied by Simplicity Software 

Technologies Inc. The name of the activation file is: MC_Act.lic. 
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¶ Run the application in your normal manner. 

 
¶ Open the File menu and expand the Software Activation sub menu. 

¶ Click on Install License Activation File option. 

¶ From the common Open file type dialog, browse to where you saved the activation file as 

supplied from Simplicity Software Technologies. The file name should be: MC_Act.lic 

¶ Select the file and click Open. 

¶ Restart Maintenance Coordinator. 

¶ The program should now be a full working version.  

Activation Files  
Please note that this activation file can be distributed to you through email or on other computer media. 

This file must be kept in a safe location and will be needed to activate the software on any computer or 

terminal it will be installed on. Feel free to make a single copy of this activation file for safeguarding.  

Be aware that sharing the Activation file with persons or organizations other that 

who it licensed to is strictly prohibited, and is in violation of federal and 

international copyright laws. Both parties could be prosecuted. 

IMPORTANT NOTE ς Please note that validating the software is only part of the activating procedure. 

This step will only unlock a demo for a period of at least 45 days. In order to continue to use the 

software a Software Key must also be entered. Also note that the software will function without any 

limitations whatsoever within this 45 day period. 

Entering a Software Key  
Once the inspection period (30 day return policy)has expired and full payment has been secured by 

Simplicity Software Technologies Inc. you will be supplied a software key. Once the software key has 

been supplied we recommend that you enter it immediately. If not entered within 45 days of the 

activation date, the software will lock you out. 

Also note that we normally use first class mail to deliver these software keys to you, so please be on the 

lookout for this letter. 
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To enter your software key: 

¶ Run the application in your normal manner. 

 
¶ Open the File menu and expand the Software Activation sub menu. 

¶ Click on Enter Software Key option. 

 
¶ Enter the key in the space provided and click OK. 

Why Software Keys 
Software keys are our way of extending credit to our customers. When the software is waiting for a 

software key to be issued, it operates without limitation for a period of not less than 45 days. Most, if 

not all our software offerings carry a 30-days money back guarantee, and also have a net due with the 

same time period. Software keys allow us to honor both of these conditions. 

INPORTANT NOTE: As with validating the software, the software key must also be used for each 

installation. Please keep the software key information and the activation file in a safe place. 
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Moving Between Modules  
The Maintenance Coordinator program is arranged in modules, with each module providing its own 

ŦǳƴŎǘƛƻƴǎ ŀƴŘ ŦŜŀǘǳǊŜǎΦ ¢ƘŜ ƳƻŘǳƭŜǎ ŀǊŜ ŀŎŎŜǎǎŜŘ Ƴŀƛƴƭȅ ǘƘǊƻǳƎƘ ǘƘŜ ǳǎŜ ƻŦ ǘƘŜ ǇǊƻƎǊŀƳΩǎ aŀƛƴ aŜƴǳ 

screen. 

The following illustration is from the Professional Edition; your menu may be different depending on 

user rights and purchased modules. 

 

To navigate between program modules: 

Option One 

¶ Move to the main menu and click on a button that best describes the module you want to 

access. 
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Option Two  
¶ From the main menu open the Modules menu and select the module of your choice. 

 
¶ If you purchased the Professional Edition or added modules, expanding the Professional and 

Add-Ons menu will provide you with more options. 

Getting Instant Help  
Most, if not all the modules in the system have Help documents associated with them. These are 

accessible from the Help drop down menus, normally located on a module main screen. 

The following illustrates a typical help menu. These are also normally located on the right side of the 

ribbon control. 

 

Pressing F1 from a screen that help is available on, will pull up the main help file associated with the 

module you are currently working with. 

Pressing F2 will allow you browse and open any of the available help documents. 

Main Program Settings  
The Program Setting allows you setup general features that will be pretty much global to the 

application. Many of the individual modules in the system can also have other settings that pertain to 

that module only and in many cases maybe local the activate computer only. 

To configure the program settings: 

¶ Login to program with Administrator rights. 
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¶ Move to the Main Menu screen of the program. 

¶ Open the Admin drop down menu and select the Main Program Settings option. 

Company Information and Logo  
The information found on this tab can be used on various documents generated by the application. 

 

To setup your company information and logo: 

¶ Move to the Company Information tab. 

¶ Move through the various fields of this tab, and enter the appropriate information for each of 

the fields.  The following explains the fields on this tab: 

o Company Name ς This alpha/numeric field can contain up to 50 characters and is used 

ǘƻ Ƴŀƛƴǘŀƛƴ ȅƻǳǊ ŎƻƳǇŀƴȅΩǎ ƴŀƳŜΦ 

o Address ς These two alpha/numeric fields can contain 50 characters each. Use these 

fields to record street and PO Box information. 

o City - This alpha/numeric field can contain up to 50 characters and is used to maintain 

the city your company is located in. 

o State or Region - This alpha/numeric field can contain up to 50 characters and is used to 

maintain the state or region your company is located in. 
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o Postal Code - This alpha/numeric field can contain up to 12 characters and is used to 

maintain your postal or zip code. 

o Telephone No - This alpha/numeric field can contain up to 20 characters and is used to 

maintain your telephone number. 

o Fax No - This alpha/numeric field can contain up to 20 characters and is used to 

maintain your fax number. 

o Web-Site ς There is no size limitation to this alpha/numeric field and is used to store 

ŎƻƳǇŀƴȅΩǎ ǿŜō site or URL. 

o Company Logo ς This image should measure approximately 1 inch by 1 inch, and 

supports the following formats: bmp, gif, jpg, ico, png and tif. 

Auto Email Settings  
You have a few setup options with the Auto Work Orders Email feature. The automatic emailing of work 

order is performed from within the Main Menu module, and the program checks for new documents 

approximately every 5 minutes. As new items are found, the application will email responsible people 

copies of actual work orders. 

 

 The following are the elements found on this tab: 
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¶ Export File Format ς This setting tells the program what file format to use when emailing work 

orders. It also specifies what action to take. The following are the options of the drop down. 

o Acrobat PDF ς This option emails copies of work order in the PDF format. 

o Rich Text Format RTF ς This options emails copies of work orders in the RTF format. 

These types of documents can be opened and edited in many word processors. 

o Auto Print Only ς This option prints work orders directly to the default printer. 

o Mail PDF and Print ς This option both email PDF documents and prints them to the 

default printer.  

o Mail RTF and Print ς This option both email RTF documents and prints them to the 

default printer.  

¶ Work Order Types ς This options tells what type of work orders to process. The options here 

are: 

o Recurring Types (PMS) 

o Standard Work Orders 

o All Work Order Types 

¶ Who to Email ς This option allows you to specify which resource assignments to send email to. 

Options here include: 

o Resource Assignment 1 

o Resource Assignments 1 and 2 

o All 3 Resources 

Besides the email options setup here, the program can optionally email the other 

recipients as specified in the Maintenance Scheduler module. 

o Days in Advance ς This setting specifies how many days in advance, as it relates to 

scheduled start dates, to send or print the work orders. 

¶ Allow sending emails from this computer ς Checking this option allows sending emails from this 

computer. 

¶ Allow printing from this computer ς Checking this option allows the printing of work orders 

from this computer. 

Note that once the work orders are send or printed from any computer, the Send flag is set preventing 

the process from repeating 

New Email Notices 
When various items are created and entered into Maintenance Coordinator, you can have the 

application send notices to the recipients of your choice about these new items. 

Supported are notices for the entry of the following items: 

¶ New Work Requests Notices ς These notices will be sent when new work requests are entered 

in to the systems either manually, or through the use of the (optional) Remote Service Requests 

module. 
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¶ New Purchase Requisition Notices ς These notices are sent when new Purchase Requisitions 

are found in the system. 

¶ New Open Issue Notices ς These notices are sent when new issues are found in the system, 

these issues have a status of Needs Attention, or Urgent issue, and they were created in either 

of the two issues modules. The Issues tracking feature is part of the Maintenance Coordinator ς 

Professional Edition, or as an add-on to the Standard Edition.  

 

To setup who receives email notices about new document creation: 

¶ Move to the group you want to setup the recipient(s) on. 

¶ Check the Allow Notices check box. 

¶ Move to and click on the Select button. 

¶ From the invoked Mail Recipients dialog, select and add the recipient or recipients you want to 

send email notices to. 

¶ Click on the Select button. 

¶ Repeat for each available group on this tab. 

The system will be checked in the same time frame as the Auto Email Feature. Also note that multiple 

recipients are separated by a semi-colon (;), and you can type in these recipients in place of selecting 

them from the Mail Recipients lookup. 
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Other Settings  
On the Other Settings tab of the Main Application Settings dialog, you have the following options: 

¶ Conserve Ink on Reports ς When checked, the application will try to remove some of the ink 

usage on some of the built in reports 

¶ Email Settings ς This allows you to setup the internal email feature for use with the built in 

Email Composer, and for the auto email features. This will be outlined in the next section. 

 

¶ Database Connections ς This allows you to setup your database connections as outlined earlier 

in this chapter. 

Email Settings  
If you plan on using any of the built-in email features, then you will need to setup your internal email 

settings. The email component we used supports non-secured email connection, SSL connections and 

TLS connections. These settings allow use with a variety of mail servers, including, but not limited to free 

Gmail accounts. 

To access Email Settings from the Main Menu: 
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¶ Login to program with Administrator rights. 

¶ Move to the Main Menu screen of the program. 

¶ Open the Admin drop down menu and select the Main Program Settings option. 

¶ Move to the Other Settings tab and click on the Email Setting button. 

To access Email Settings from the Email Composer: 

¶ Open the File menu. 

¶ Click the Email Settings option. 

Outgoing Settings  
This tab allows you to setup user information and name of your Outgoing Mail Server.  

The following image illustrates the elements of this tab: 

 

¶ User Name ς This field is used to identify the default system user. 

¶ Email Address ς This field is used to identify the email address of the default email account. 

¶ Outgoing Mail Server (SMTP) ς This the SMTP server name the account is setup to use. 

Advanced Settings 
The setting on the tab allows you to specify log on information, outgoing port number, and the use of 

Secured Password Authorization. 

The following image illustrates the elements of this tab: 
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¶ Outgoing Mail Server Port ς This setting both specifies the outgoing mail server port and the 

type of connection to use. Option here include: 

o 25 (Regular Connection) 

o 26 (Regular Connection) 

o 465 (SSL Port Connection) 

o 587 (Start TLS Connection)   

¶ Requires Login using Secured Password Authorization (SPA)  - Most remote servers requires 

this setting to be used. If the server your using required this then check this option. 

¶ Log On Using ς You need to specify this information even if SPA is not used. 

¶ User Name  - Specify the name user on your account. 

¶ Password ς Specify you log on password. 

How to Get Started with Maintenance Coordinator  
With Maintenance Coordinator we have tried to make it possible to enter things as needed. This to say, 

if you need to add a mechanic to a work order, you can add the mechanic to the database at the time 

the work order is created. Most of our lookup screens allow you to add new items as you are selecting 

them. This approach allows you to get started using the program almost immediately.   

The first thing you need to setup is your databases. Everything you enter into the program will be saved 

to these databases. Please refer to the Security and Databases chapter for more information on how to 
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do this. Creating new databases is as simple as opening and saving files. Once these new databases are 

created, be sure to point to them. 

¢ƘŜ ƴŜȄǘ ŀǊŜŀ ǘƻ ŜȄǇƭƻǊŜ ŀƴŘ ǎŜǘǳǇ ŀǊŜ ǘƘŜ ǇǊƻƎǊŀƳΩǎ ƎŜƴŜǊŀƭ ǎŜǘǘƛƴƎǎΦ ¢Ƙƛǎ ƛǎ ŦƻǳƴŘ ǳǎƛƴƎ ǘƘŜ !ŘƳƛƴ 

drop down menu and selecting the Program Settings option. This is accessible from the main menu of 

the application. Here you setup company information, your company logo, your e-mail server, database 

paths, and other general information. The most important of these is setting up your databases. You can 

always configure the other setting later on if needed. 

Work Orders need the following items available for their creation: 

¶ Mechanics or employees responsible for their completion. 

¶ Equipment the work order will be assigned to. 

¶ Materials or spare parts that will be needed to complete the work order. 

¶ Safety Instructions.  

¶ The actual work instructions. 

The items in the above list should be available for the creation of work orders. Equipment information is 

perhaps the most important of these items and you should work on this list first. Gather information 

such as descriptions, serial, model and reference numbers. More information can always be added later 

as needed. 

Also dealing with the equipment, you also want to gather any special safety instructions along with 

recommended planned maintenance instructions. This information is usually available from the 

equipment vendor or manufacturer. If you can obtain this information in electronic form it would be an 

added plus as you should then be able to just copy and paste this information into the program (a great 

time-saver).  

The next thing you need to do is build your database of task instructions. This is necessary for planned 

maintenance tasks only, as you can and should reuse the same set of instructions over and over. For 

example, say you have five air compressors in your facility it would only make sense to reuse the same 

set of instructions for all five air compressors.  

Once you have built your database of task instructions, you should do the same thing with your safety 

instructions. Unlike task instructions, safety instructions should be assigned to each and every work 

ƻǊŘŜǊ ǊŜƎŀǊŘƭŜǎǎ ƻŦ ǿƘŜǘƘŜǊ ƛǘΩǎ ŀ ǇƭŀƴƴŜŘ Ƴŀƛƴtenance or repair type. 

Basically, with the above completed, you are ready to start using the program for the creation of both 

planned maintenance and repair types of work orders. Please keep in mind that these have only been 

basic recommendations to get you up and running quickly, there are many more features you need to 

consider while using this powerful and feature rich CMMS application. 
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#ÏÍÍÏÎ 5ÓÅ &ÅÁÔÕÒÅÓ 

This chapter outlines features that are in common use throughout the software system. Some of the 

features explained here may apply to every module in the system, whereas others may only apply to a 

couple of modules. By placing common features together we have reduced the documentation size, and 

hopefully at the same time helped to reduce the learning curve. 

Procedures outline in this, and all other chapters assumes the user has basic computer skills and has 

worked in the Windows environment before. Also note that features such as opening and saving files 

can change by operating systems and because of this will not be discussed here. 

Tool Tips  
Many of the controls on a screen or within a ribbon control have what are known as Tool Tips. What 

these actually are, are little help screens that provide information on what a button or control does. The 

image shown is an example of a tool tip message. 

 

To activate a Tool Tip just place your mouse over a control that supports this feature. If supported, the 

Tool Tip message will be displayed for a few seconds. 

Shortcut Bar (Outlook Style)  

 

The Shortcut Bar allows you to branch to either different parts of the module or program, and can 

execute commonly used routines. This control breaks things into different groups. Clicking on the large 

bars opens different groups and displays different options. Clicking on an item within the shortcut bar 

will activate that option.  
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Clicking the arrow < in the upper left corner will minimize the Shortcut bar to the left of the screen. To 

expand a minimized Shortcut bar, click on the button > containing in its title on the left side of the 

screen. 

Note that most if not all the options on the shortcut bar are also available from drop down menus, 

ribbons, and the Go menu when available. 

Tasks Panels 

 

The Tasks Panels allow you to execute commonly used routines quickly. This control breaks things into 

different groups. Clicking on the arrows will expand or close the different groups and displays different 

options. Clicking on an item within the Task Panel will activate that option.  

Note that most if not all the options on the Task Panel are also available from drop down menus, and 

the ribbon control when available. 

Clicking the PIN in the upper left corner will either lock the Task Panel in place, or allow it to minimize 

when not in use. To expand a minimized Task Panel, click on the button containing its title on the left 

side of the screen. 

Tile Controls  
Tile Controls are used though-out the application to provide options to the end user. Introduced with 

ǘƘŜ ǊŜƭŜŀǎŜ ƻŦ aƛŎǊƻǎƻŦǘΩǎ ²ƛƴŘƻǿǎ у h{Σ ǘƘŜǎŜ ƎǊŀǇƘƛŎŀƭ ōǳǘǘƻƴǎ ǿƻǊƪ ƳǳŎƘ ƛƴ the same way as a 

standard button. We use them with our main menu to allow the user to navigate to the various modules 

of the system. We also use them with our documents to help represent the document types and access 

options. 
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When all the buttons will not fit on a screen, you can click on a non-button area to scroll the control. 

This is done by clicking and holding the left mouse button and then moving the mouse in the direction 

you wish to scroll. 

The keyboard arrow keys can also be used to navigate through the Tile Control buttons. A slight 

highlight around the button will be displayed to show the selection. Once a button is selected, pressing 

the Enter key will activate the selection. 

Using the Ribbon Control  
¢ƘǊƻǳƎƘƻǳǘ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ȅƻǳΩƭƭ ŦƛƴŘ ǘƘŜ ǎǘŀǘŜ-of-the-art Ribbon Control. This is the replacement for 

the conventional menu control that has been used in applications for years. We have based our control 

on the most modern Office styles, which is also part of the Microsoft Office Fluent user interface.  

NOTE: This control as with many of the controls used by this system can have their appearances 

change somewhat by the selected theme in use. 

The following illustration outlines the elements of the basic Ribbon Control: 
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Application Menu (File)  
In the upper left hand corner of ribbon control is the Application or File menu button. Clicking on this 

button opens a drop down that closely resembles the old File menu. Once clicked, the user can then 

click on the various other buttons or options found there.  

 

Please note that in most cases, the Application button is a direct replacement for the File menu. 

Quick Access Toolbar  

 

The Ribbon control has a Quick Access Toolbar associated with it. This toolbar normally contains 

ŦŜŀǘǳǊŜǎ ǘƘŀǘ ŀǊŜ ǿƛŘŜƭȅ ǳǎŜŘ ǘƘǊƻǳƎƘƻǳǘ ǘƘŜ ǎȅǎǘŜƳΦ hƴŜ ǎŜǘ ŎƻƴǘǊƻƭǎ ȅƻǳΩƭƭ ŦƛƴŘ ƛƴ ǿƛŘŜ ǳǎŜ ŀǊŜ ǘƘŜ 

data controls that are used to scroll through the records of the database. 

Changing Ribbon Pages 
Controls on a ribbon are grouped in Pages. Pages appear on the ribbon with the same look as a 

conventional tab control. To access controls on different pages simply click on the page header, and 

then click on the appropriate control. 
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Command Region 
The command region of the ribbon control can contain a variety of different other controls. Examples of 

controls that may be placed there are buttons, drop drown list, color and font pickers and others. The 

most common controls found here would be buttons. Clicking a button control normally launches some 

specific function of the application. 

Ribbon ɀ Keyboard Access 
The options available on a ribbon control can be accessed by using your keyboard in place of your 

ƳƻǳǎŜΦ ¢Ƙƛǎ ƛǎ ŘƻƴŜ ǿƛǘƘ ŀ ŎƻƳōƛƴŀǘƛƻƴ ƻŦ ǘƘŜ Ψ!ƭǘΩ ŀƴŘ ǎƻƳŜ ƻǘƘŜǊ ŎƻƳōƛƴŀǘƛƻƴΦ 

 

To access options of the ribbon control using your keyboard: 

¶ tǊŜǎǎ ŀƴŘ ǊŜƭŜŀǎŜ ǘƘŜ ΨAltΩ ƪŜȅΦ ¢Ƙƛǎ ŀŎǘƛƻƴ ǿƛƭƭ ŘƛǎǇƭŀȅ ǘƘŜ ŀǾŀƛƭŀōƭŜ ƪŜȅ ŎƻƳōƛƴŀǘƛƻƴǎ ǘƘŀǘ Ŏŀƴ 

be used. 

¶ To activate an option press the assigned key or keys as displayed. In the example showing, 

pressing the H key would activate the History Log report option.  

Ribbon ɀ Hot Keys 
Like the traditional program menus, ribbon items can be assigned hot key shortcuts. These are keyboard 

key combinations that access commonly used features. Normally these hot key assignments use the 

Ψ/ǘǊƭΩ ƪŜȅ ŀƴŘ ŀƴƻǘƘŜǊ ƪŜȅ ǘƻ ŀŎŎŜǎǎ ŀ ŦŜŀǘǳǊŜΦ IƻǿŜǾŜǊΣ ƻǘƘŜǊ ƪŜȅ ŎƻƳōƛƴŀǘƛƻƴǎ Ƴŀȅ ŀƭǎƻ ōŜ ǳǎŜŘΦ 

Some examples of hot key assignments: Ctrl + N for new, Ctrl + S for save, Ctrl + C to copy text, Ctrl + X 

to cut text, Ctrl + V to paste text, and many others. 

Program Menus  
In various places throughout the application are pull-down or program menus that are located directly 

beneath the screen header or title bars. You'll also notice that these menus will change depending on 

the screen or module that is currently displayed. 
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These menu options allow for easy access of many features and functions the program has to offer to 

the user. 

There are a couple of different methods in which the user can access the contents of pull down menus 

and are outlined next. 

¶ Press the ALT key along with the highlighted letter to access the pull down menus.  

¶ Press the highlighted letter to access the options of that menu. 

¶ Use the arrow keys to highlight the desired menu option and then press ENTER. 

¶ Put the mouse pointer on the desired option, and then click on the menu option of your choice 

with the left mouse button. 

If the menu option of your choice has a HOT KEY assignment, you can use that to select the menu 

option. Some of the HOT KEYS used by the program are CTRL + X for cutting text, and CTRL + V for 

pasting text. 

Data Controls  
Located in various areas of the program are Data Controls. These controls allow the user to move 

through records in a database and when available add, remove, save, and cancel changes to the 

database. 

 

 

The two images shown are the two data controls used by the application. The first one is normally found 

ƛƴ ǘƘŜ ǊƛōōƻƴΩǎ ǉǳƛŎƪ ŀŎŎŜǎǎ ǘƻƻƭōŀǊΣ ŀƴŘ ƛǎ ƴƻǊƳŀƭƭȅ ǳǎŜŘ ǘƻ ŦǳƴŎǘƛƻƴ ǿƛǘƘ ŀ ƳƻŘǳƭŜΩǎ Ƴŀƛƴ ŘŀǘŀōŀǎŜΦ 

The second control is normally used with support databases. Attachments database is a good example. 

bƻǘ ŀƭƭ ŜƭŜƳŜƴǘǎ ƻŦ ŀ Řŀǘŀ ŎƻƴǘǊƻƭ ǿƛƭƭ ōŜ ǇǊŜǎŜƴǘ ŀǘ ŀƭƭ ƭƻŎŀǘƛƻƴǎ ƛǘΩǎ ǳǎŜŘΦ CŀŎǘƻǊǎ ǘƘŀǘ Ŏŀƴ ŀŦŦŜŎǘ ŀƴ 

ŜƭŜƳŜƴǘΩǎ ŜȄƛǎǘŜƴŎŜ ŎƻǳƭŘ ōŜ ŀ ǳǎŜǊΩǎ ǊƛƎƘǘǎΣ ƻǊ ǿƘŜǘƘŜǊ ǘƘŜ ŦǳƴŎǘƛƻƴǎ are needed. 

The following are the elements of the data control, reading left to right. 

¶ Move First ς Moves to the first record in the database. 

¶ Previous Page ς Moves a page of records at a time (not available in the quick access toolbar). 

¶ Move Previous - Moves to the previous record in the database. 

¶ Move Next ς Moves to the next record in the database. 

¶ Next Page ς Moves a page of records at a time (not available in the quick access toolbar). 

¶ Move Last ς Moves to the last record in the database. 

¶ Add/Append ς Adds a new record to the database. 

¶ Delete/Remove ς Removes the selected record from the database. 



Maintenance Coordinator 

 

Simplicity Software Technologies Inc | Using the Lookup Grids 61 

 

¶ Post/Save ς Post or saves recent changes to the database. 

¶ Cancel Edit ς Cancels recent changes and restores information. 

Using the Lookup Grids  
¢ƘǊƻǳƎƘƻǳǘ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ȅƻǳΩƭƭ ŦƛƴŘ Ψ[ƻƻƪǳǇ DǊƛŘǎΩΦ ¢ƘŜǎŜ ŀǊŜ ŦƻǳƴŘ ƻƴ ǘƘŜ [ƻƻƪǳǇ ǘŀōǎ ƻŦ ǘƘŜ 

ƳŀƧƻǊƛǘȅ ƻŦ ǘƘŜ ƳƻŘǳƭŜǎΣ ǘƘŜȅΩǊŜ ŀƭǎƻ ŦƻǳƴŘ ƻƴ ǘƘŜ ƳŀƧƻǊƛǘȅ ƻŦ ŀǎǎƛƎƴƳŜƴǘ ŘƛŀƭƻƎ ǎŎǊŜŜƴǎΦ ¢ƘŜ ǇƛŎǘǳǊŜ 

provided is an example of a typical Lookup Grid as found on a Lookup (assignment) dialog screen. 

 

Grouping Items  
You can group items in the Lookup grid by any of the available columns.  Just click and hold the column 

and then drag and drop it into the area just above the columns headings. 
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Once grouped, you can expand or collapse a group by clicking on the appropriate symbol adjacent to the 

group. Also note that you can create a tree type structure with these groups, and you are not limited to 

a single group. 

Filtering Records  
To help facilitate the easy lookup of items, most of the lookup grids employ a Filter row. So if you know 

ǿƘŀǘ ȅƻǳΩǊŜ ƭƻƻƪƛƴƎ ŦƻǊ ȅƻǳ Ŏŀƴ ǘȅǇŜ ƛƴ ǘƘƛǎ Ǌƻǿ ǘƻ ŦƛƭǘŜǊ ƻǳǘ ǳƴǿŀƴǘŜŘ ǊŜŎƻǊŘǎ ŀƴŘ ƴŀǊǊƻǿ Řƻǿƴ ȅƻǳǊ 

search. 

 

To filter records  

¶ Move to the column you want to filter records by and click in the empty row just below the 

column header. 

¶ Start typing in your filter and watch the grid begins to shrink as you go. Effectively filtering out 

non matching records.  

Resorting the Information  
The majority of the Lookup grids used by the application allow you to resort the information by any 

column of your choosing. 
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To resort the records  

¶ Move to and click on the column header. 

¶ To resort in the other direction, click the header again. 

Moving Columns  
The majority of the Lookup grids allow you to rearrange the columns found on the grids, thereby 

allowing you to customize the grid layout to your liking.  

 

To rearrange columns: 

¶ Just click and hold the column of your choice. 

¶ Drag the column to its new location and release the mouse button. 

Adding Columns 
The majority of the Lookup grids allow you to add database columns to the grids. This is especially useful 

when we left out a particular column that you just must have. 
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To add a database column: 

¶ Right mouse click in the column headers area to pull up a context menu. 

¶ Click on the Column Chooser option. 

¶ Double-click on the column or columns you want to add. 

¶ Click on the Close button in the upper right corner when done. 

Please note that some of the available fields may not display information that the average user will 

understand.  Many of these fields are used internally by the application and are not meant to show data 

directly to the user. 

Removing Columns  
Just as we allow the user to add columns to a grid, you can remove them as well. To remove a column: 

¶ Right mouse click on the column header that you want to remove. 

¶ Click on the Remove this Column option 

Other Options  

There are other options available to the Lookup Grids that the user can explore on their own. To access 

these options just right clƛŎƪ ǿƛǘƘƛƴ ǘƘŜ ƎǊƛŘΩǎ ƘŜŀŘŜǊ ŀǊŜŀΦ 

 

Save Grid Layouts 
Most of the settings we just discussed will reset themselves when the screen is closed and reopened. 

The exception to this rule is found when the Lookup grid is saved by the user. In most cases we made 

this grid savable via the File menu. When a File menu is not available, you may also be able to save the 

grid by right mouse clicking in the rows part of the grid. This will invoke a popup menu. Once your grid is 

customized to your liking, save the grid and the settings so they will be reapplied when reopened. 
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The following illustrations shows both of the Main Grid Options as found in the File menu or the Popup 

menu attached to the lookup grid: 

 

Accessing the Main Grid Options (when available)  
To access the Main Grid Options: 

¶ aƻǾŜ ǘƻ ŀƴŘ ŎƭƛŎƪ ƻƴ ǘƘŜ ǊƛōōƻƴΩǎ File menu. 

¶ Click on the Main Grid Options button to expand the pop out sub menu. Options on this sub 

menu include: 

o Print Lookup Grid ς This action will invoke a print preview of the main grid. 

o Save Grid Layout ς This option saves any customization you may have applied to the 

grid. Once saved, these customizations will be reapplied when the module or lookup 

screen is next shown. 

o Reset Grid Layout ς This option will reset the grid back to the settings that was supplied 

by us. You will see the results of this once the module or lookup screen is next shown. 

Accessing the Main Grid Options from the Popup Menu (when available)  
When the File menu is not available, we have provided (in most cases) a popup menu that allows for the 

same options. To access the Main Grid options via the popup menu: 

¶ Move to the Lookup grid. 

¶ Right mouse click in the database rows part of the grid. This will invoke the popup menu. 

Options available here mirror those found on the File menu. 

Searching 
The built-in Search Panel provides an easy way of searching against multiple columns. It is 

displayed above the Group Panel. The Search Panel contains a search box and control buttons. 

https://documentation.devexpress.com/WPF/CustomDocument6215.aspx
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To access the Search Panel, click on the Search button in the ribbon. You can close the panel by 
clicking this button again or clicking the X button from within the panel. When the Search button is 
not available in the ribbon, you can open the Search Panel by first clicking with in the grid and then 
clicking CTRL+F. Clicking ESC - Clears the search box. If the search box is empty, pressing ESC 
closes the Search Panel. 

In its simplest form, search criteria consist of a single word. To search for a string containing a 
space character, specify this string in quotation marks. Without quotation marks, words separated 
by the space character are treated as individual conditions (using the OR logical operator by default 

To search against a specific column, precede a search string with the column's display name plus a 
colon character. 

Precede a condition with "+" to select records that match this condition. Other records will be 
excluded from the result. The "+" specifier allows you to implement the logical AND operator. 

Precede a condition with "-" to exclude records that match this condition from the result set. 

Examples: 

Search Criteria  Description  

register Selects records that contain the "register" string in any search column.  

check register Dave Selects records that contain either "check" or "register" or "Dave" strings in any 
search column. 

"check register" Selects records that contain "check register" in any search column. 

screen +"Richard Fisher" Selects records that contain both "screen" and "Richard Fisher" in search columns. 

data +entry -mark Selects records that contain both "data" and "entry" in search columns, excluding 
records that contain "mark". 

menu mask -file Selects records that contain "menu" or "mask", excluding records that contain "file". 

Note: Searches performed using the Search Panel is case insensitive. 
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Scanned Lookups (Barcodes Support)  
Many of the Lookup screens of the system use routines that are designed to work with barcode 

scanners. With these routines the user only needs to select the control, scan a barcode, and if available, 

the corresponding record should be selected.  

The ǎȅǎǘŜƳ ǎǳǇǇƻǊǘǎ ǘƘŜ ΨƪŜȅōƻŀǊŘ ǿŜŘƎŜΩ ǘŜŎƘƴƻƭƻƎȅ ŦƻǊ ƛǘǎ ƛƴǇǳǘ ǎŎŀƴƴƛƴƎ ŘŜǾƛŎŜǎΦ ¢ƘŜǎŜ ǘȅǇŜǎ ƻŦ 

scanners are widely available and are normally very cost effective. We they actually do is read a barcode 

and then sends the key stokes to the selected control as if typing this information from a keyboard. 

 

To use the scan lookup: 

¶ Move to a lookup screen that supports this feature. If supported there should be a Lookup 

button adjacent to an input text box. 

¶ Click on the Lookup button. This does two things: It clears the input control of any previously 

scanned values and selects the control in preparation of the next scan. 

¶ Using a supported scanner, scan the barcode. The program will filter the database by the 

scanned value. 

NOTE: If you know the reference value of ǘƘŜ ǊŜŎƻǊŘ ŀƴŘ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ŀ ǎŎŀƴƴŜǊΣ ȅƻǳ Ŏŀƴ ŀƭǎƻ ǘȅǇŜ 

this information directly into the lookup input box. 

Tab or Folder Controls  
Tab or Folder Controls are used throughout the application. The main purpose of these tabs is to group 

information and to enable more information to fit on the screen. The following picture displays a typical 

Folder control with 3 tabs. These folder controls are often just referred to as tab controls. 

 

To move from one tab to another simply click on the preferred tab. 

Group Controls  
Group Controls are used throughout the application. Their primary purpose is to tie information 

together into logical groups. This grouping facilitates a better understanding of items by the end user. 

The following illustration show a typical group control along the top. The lower half of the image shows 

a tab control with two tabs. The active or selected tab also contains two more group controls. 
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Selected Group Controls can be opened and collapsed by the user. The controls that you can open and 

collapse have an arrow icon in their upper left hand corners. You just click on these arrows to open and 

collapse these controls. 

Date Controls  
Date Controls are used throughout the application for the purpose of setting or selecting dates.  

 

To display the date control: 

¶ Click on the Down Arrow along the right side of the control. 

To select a date: 

¶ Click on the date within the control. 

¢ƻ ƳƻǾŜ ǘƻ ǘƻŘŀȅΩǎ ŘŀǘŜΥ 

¶ /ƭƛŎƪ ƻƴ ǘƻŘŀȅΩǎ ŘŀǘŜ ƴŜŀǊ ǘƘŜ ǘƻǇ ƻŦ ǘƘŜ ŎƻƴǘǊƻƭΦ 

To scroll through the months: 
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¶ Click on the forward or back arrows within the control. 

To clear the entered date: 

¶ Click on the word Clear near the bottom of the control. 

Editing Values, Selecting Text and Using the Clipboard    

Select and Deselect Editor's Contents  
To select all text within an editor, you can invoke the Editor Context Menu and choose Select All. To 

select a part of the edit value, click on a position where the selection should start, drag the pointer to 

the end position and then release the mouse button. 

Additionally, the following keyboard shortcuts allow you to manage selections. 

Shortcut  Description  

CTRL+A or F2  Select all within an editor.  

SHIFT+ARROW  Extends or shrinks the selection by one character.  

CTRL+SHIFT+ARROW  Extends or shrinks the selection by one word.  

 

Clipboard Operations  
Clipboard operations are supported for editors that support caret moving.  

To copy selected text into the clipboard, do the following.  

¶ Press CTRL+C or CTRL+INSERT.  

¶ Open the Editor Context Menu and select Copy.  

To paste text from the clipboard, do the following.  

¶ Press CTRL+V or SHIFT+INSERT.  

¶ Open the Editor Context Menu and select Paste.  

To cut some text from an editor into the clipboard, do the following.  

¶ Press CTRL+X or SHIFT+DELETE.  

¶ Open the Editor Context Menu and select Cut.  

Delete Selected Text  
To delete the selected text within an editor, do one of the following:  
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¶ Press DELETE or BACKSPACE. 

¶ Open the Editor Context Menu and select Delete.  

Undo  
To undo the last text editing operation, do one of the following:  

¶ Press CTRL+Z.  

¶ Open the Editor Context Menu and select Undo.  

Note: After you've undone an operation, you can return to the previous edit value by executing the 

Undo command once again. 

Change Numeric Values  

 

 To increment a value, press UP ARROW. To decrement the value, press DOWN ARROW. Or, use the 

mouse wheel.  

Edit Images  
To copy, cut, paste, load and save images in image editors, right click the image and select the required 

command via the context menu:  

 

Editor Context Menu   
Text editors support a context menu providing common commands. To open the menu, right-click on an 

editor. 
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Drop Down List Boxes  
Used throughput the application are drop down list boxes. The purpose of these controls is to allow the 

user to select an item from a list of choices. 

 

To use a drop down list box: 

¶ Click on the down arrow on the right side of the control. 

¶ Use the arrows on the scroll bar to move through the list. 

¶ Once located, click on the item of your choice to use it. 

Data Quick Entry  
One time saving feature we have installed in most of the data input screens used by the application are 

what we call "Data Quick Entry" routines. These routines are used to store information that you would 

use repeatedly. The idea behind this feature is to allow you to type in commonly used information just 

once. The next time you need it you just call up the routines, select the text from a list, and have it 

automatically inserted for you. 

Each text field in the application that works with these routines has their own filtered databases. For 

example, if you call up the listing while in the "Classification" text field, you'll get a different list of items 

than if you wŜǊŜ ƛƴ ǘƘŜ άtǊƻƧŜŎǘέ field. 
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Using Data Quick EÎÔÒÙ Ȭ$ÒÏÐ $Ï×Îȭ ,ÉÓÔÓ 
In many cases you access the items of the Quick Data Entry from drop down lists. When used in this way 

ǘƘŜǎŜ ƭƛǎǘǎ ŀǊŜ ŀƭǎƻ Ψ!ǳǘƻ /ƻƳǇƭŜǘŜΩ ŜƴŀōƭŜŘΦ ¢Ƙƛǎ ƛǎ ǘƻ ǎŀȅ ǘƘŀǘ ŀǎ ȅƻǳ ǘȅǇŜΣ ǘƘŜ ǇǊƻƎǊŀƳ ǿƛƭƭ ǎǳƎƎŜǎǘ ŀƴ 

ƛǘŜƳ ǘƘŀǘΩǎ ŀƭǊŜŀŘȅ ƛƴ the list. 

 

You add and delete items in these drop downs by click on the Manage button adjacent to these fields. 

Calling Up the Data Quick Entry Screen  
To call up the Data Quick Entry list from one of the supported text input fields: 

¶ Click on the ellipse (Χ) button, click on the Manage button or click the Select button adjacent to 

the field that you want to make an assignment to. 

 

 

Adding New Quick Entry Items  
Before you can begin using the Quick Entry option, you'll need to add information into the listing. Once 

the list has been populated the information will then be available for insertion. 
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To add information to the Quick Entry list, you must: 

¶ Click on the Add New button. 

¶ Type in the information you want included in the listing. This text can be any combination of text 

characters and numbers and have a maximum length of 30 characters. 

¶ Press or click on the OK button to accept the text and add it to the list. 

¶ Click on the Save Changes button to save your changes. 

Selecting Text for Insertion  
Once you have information installed into the Quick Entry listing, you can use and reuse this text any 

countless number of times. 

The procedure for selecting text from the Quick Entry list and inserting it into the appropriate field: 

¶ Click on the ellipse (Χ) button, click on the Manage button or click the Select button adjacent to 

the field that you want to make an assignment to. 

¶ Move to the lookup grid and click on the selection of your choice. 

¶ Click on the Accept button. 

Deleting  Item from the Qu ick Entry List  
If you have information in the Quick Entry list box that you no longer feel is valid; you can delete it by 

following these steps: 

¶ Click on the ellipse (Χ) button, click on the Manage button or click the Select button adjacent to 

the field that contains the list you want to edit. 

¶ Move to the lookup grid and click on the selection of your choice. 

¶ Click on the Remove button. 

¶ When prompted if you want to continue, click YES. 

¶ Click on the Save Changes button to save your changes. 

Data Quick Entry: Drop -Down Lists  

 

Many of the quick entry routines are also have a drop down list box associated with it.  In this case you 

would just select an item from within the list. This list also employs an auto complete feature where the 

program will try to bring up the item you need as you type in the edit area of the drop down. 

If the item you want is not within the list, you can click on the Manage button adjacent to the entry field 

to add the item as described in the previous section.  
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Attachments  
Many of the modules within the system use the Attachments Feature. This feature allows you to attach 

items to various records such as work orders, equipment records, employee records and more. 

Basically any type of document or path that can be accessed througƘ ǘƘŜ ²ƛƴŘƻǿǎΩ Start ς Run option can 

be used as an attachment. Normally you just point to a file, and when opened that file will open itself 

within with the appropriate or associated application. These can include, but not limited to pictures, CAD 

drawings, documents, web-sites and more. 

When using pictures, we highly recommend using this feature as opposed to importing them into the 

database. Picture or image files can use a lot of database space in a short amount of time. This could both 

consume database space and effect database performance. Links to image files on the other hand use 

very little space, and actually provide better support. 

 

The image provided is what the Attachment feature typically looks like. This appearance can change 

somewhat from module to module, but in general it has the same general look and features no matter 

where used. 

To add an attachment  

¶ Locate and select the record you want to add an attachment to. 

¶ Move to the Attachment section and click on the plus sign (+) in the data control located in this 

section. 

¶ From the invoked Attachments dialog, use the Browse button to search and select the file or 

document you want use as an attachment. 
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¶ Once selected, click on the Open button within the Open dialog screen. 

 
¶ If the default description for this file is not descriptive enough, then move to the Description 

text box in the Description group and edit its contents. 

¶ To test if the link actually works, click on the Test/Open button. 

¶ To accept everything and use the attachment click on the Accept button. 

To open and view an attachment  
¶ Move to the grid and click on the attachment you want to open. 

¶ Click on the Open Link button. 

To delete an attachment  

¶ Move to the grid and click on the attachment you want to delete. 

¶ Move to the data control and click on the remove (-) button. 

¶ /ƭƛŎƪ ΨYesΩ ǘƻ ǘƘŜ ŘŜƭŜǘƛƻƴ ǇǊƻƳǇǘΦ 

¶ /ƭƛŎƪ ǘƘŜ ΨEnd EditΩ ƻǊ Post button in the data control (check). 

Using Attachments on More Than One Computer  
When using attachments with more than one computer, say with a Network configuration for example, 

we suggest using mapped drives. Using a mapped drive will allow you to create the same path for each 

PC in use. If this is not done the path could change from computer to computer and the attachment will 

not always be found. For more information on mapped drives, search Windows help from My Computer. 
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Documents Trees  
The Documents Tree is used through-out the system, and its features are duplicated in each place it is 

used. Examples of areas it can be found is in the Documents Features found in many of the modules, the 

Procedures and Solutions module, and the Repair Procedures Editor used with work order instructions.  

Understanding and Using the Documents Tree  

 

The Documents Tree allows for the organization of your documents in Folders or nodes. Basically you 

are not limited to the number of folders you can create and use. You can also create as many levels of 

these folders as maybe needed (parent ς child folders). The supplied illustration shows the elements of a 

typical tree control. 

IMPORTANT NOTE: Most of the procedures outlined in this section refer to the use of pop-up menus, 

however many of these procedures can also be duplicated and be found in the ribbon control as well. 

Create a Document  Folder  
Each document in the system will be assigned to a folder or tree node in the Documents Tree. Once a 

folder is created documents can be added to it. 

4Ï ÃÒÅÁÔÅ Á ÎÅ× $ÏÃÕÍÅÎÔ Ȱ2ÏÏÔȱ ÏÒ Ȱ4ÏÐ ,ÅÖÅÌȱ ÆÏÌÄÅÒȡ 

 

¶ Right mouse clicking within a Documents Tree section will invoke a popup menu. 

¶ Click on the Add Top Folder option. 
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¶ From the invoked dialog enter the name you want to use for this folder and click OK. 

4Ï ÃÒÅÁÔÅ Á ÎÅ× Ȱ3ÕÂ &ÏÌÄÅÒȱ ÏÒ Ȱ#ÈÉÌÄ .ÏÄÅȱ 

¶ Move to the Documents Tree and click and select the folder that you want to add a new sub 

folder to. 

¶ Right mouse click within the Documents Tree section to invoke a popup menu. 

¶ Click on the Add Sub Folder option. 

¶ From the invoked dialog enter the name you want to use for this folder and click OK. 

To Remove a Folder 

¶ Move to the Documents Tree and click on the folder you want to remove. 

¶ Ensure there are no child folders or documents assigned to this folder. If there are items then 

either move and reassign these items or delete them. You cannot remove a folder if anything is 

assigned to it. 

¶ Right mouse click on the folder you want to remove to invoke a popup menu. 

¶ Click on the Remove Folder option. 

To Rename a Folder 

¶ Move to the Documents Tree and click on the folder you want to rename. 

¶ Right mouse click on the folder you want to remove to invoke a popup menu. 

¶ Click on the Rename Folder option. 

¶ From the invoked dialog edit the folder name to the way you want it and then click OK. 

To move a Folder to the Top Level or Root position  
¶ Move to the Documents Tree and click on the folder you want to move. 

¶ Right mouse click on the folder you want to move to invoke a popup menu. 

¶ Click on the Move Folder to Root (Top Level) option. 

To move a Folder and Reassign its position in the tree  
¶ Move to the Documents Tree and click on the folder you want to move. 

¶ Left mouse click and hold on the folder you want to move. 

¶ Drag the folder over the folder you want to move it to. 

¶ Release the mouse button to drop the folder in to its new location. 

Documents Feature  
Any maintenance operation is sure to accumulate a wide variety of documents. Examples of these 

documents could be warranty information, information about your equipment, notes about your 

mechanics, MSDS and the list goes on and on. These documents can also be proven to be very important 

to the day-to-day operation of your maintenance department. For these reasons we have included the 

Documents Database feature. 
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The Documents Database is included in many of our modules where we felt it would be useful. You can 

find this feature in the Maintenance Scheduler, Equipment module, Purchasing module, Contacts 

module, and HR module. The HR ƳƻŘǳƭŜ ŘƛŦŦŜǊǎ ŦǊƻƳ ǘƘŜ ƻǘƘŜǊǎ ŀǎ ƛǘΩǎ ŀǘǘŀŎƘŜŘ ǘƻ ŜŀŎƘ ƛƴŘƛǾƛŘǳŀƭ ǊŜŎƻǊŘΦ 

This allows you to maintain various documents on a single employee.  

You can create three different types of documents with this feature. One is a picture document, which 

can be in the GIF, JPG, BMP, PNG, TIF and ICO formats. The next type of documents can be the rich-text 

editor type. These editor type documents features the use of our built-in Rich Text Editor. This editor 

supports many professional features such as multiple fonts, colors, paragraph formatting, the use of tables 

and more. Documents created in our Rich Text Editor are compatible with almost all windows based word 

processors such as Word and Word Perfect or any that support the RTF format. 

The third type of available documents is the Attachments type of documents. Attachments point to other 

files store on hard drives, or other locations such as web-sites or folders. We recommend that you use 

this document type for pictures too. You can point to a picture stored on a hard drive as opposed to storing 

it directly in the database. This saves database space and improves database performance by keeping the 

database at a reasonable size. 

Working with  Documents  
There are three types of documents that can be used by this feature. Build-in Rich-Text Editor types, 

Image or picture types and links to external documents. Each document must be assigned to a folder to 

either create or use them. 
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To create a new Internal Rich -Text document  

  
¶ Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

¶ Click on the Add Document option in the ribbon control 

¶ From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. This title can contain up to 30 characters. 

¶ Move to the Document Type section and select the RTF Document option. 

¶ Click on the Accept button and the Rich-Text editor will open with your new document ready for 

editing. 

To create a new Picture/Image document  
¶ Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

¶ Click on the Add Document option in the ribbon control 

¶ From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. This title can contain up to 30 characters. 

¶ Move to the Document Type section and select the Picture/Image Document option 

¶ Click the Accept Button to invoke a file open dialog box. 

¶ Browse to where the images file is store and select the image by clicking on it. 

¶ Click on the Open button to assign the image. 

To create a new Link document  

¶ Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

¶ Click on the Add Document option in the ribbon control. 
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¶ From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. 

¶ Move to the Document Type section and select the Attachment/Link Document option 

¶ Click the Accept Button to invoke the Link Setup dialog. 

 
¶ Move to the Attachment Path section and click on the Browse button. 

¶ Navigate to where the file you want to use is stored. Select the file and click Open. 

¶ The program will ŀǎƪ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ǊŜǇƭŀŎŜ ǘƘŜ ŎǳǊǊŜƴǘ ŘŜǎŎǊƛǇǘƛƻƴ ǿƛǘƘ ƻƴŜ ōŀǎŜŘ ƻƴ ǘƘŜ ŦƛƭŜΩǎ 

name. To accept the new description reply by clicking on the OK button. 

¶ ¸ƻǳ Ŏŀƴ ŜŘƛǘ ǘƘŜ ŘƻŎǳƳŜƴǘΩǎ ŘŜǎŎǊƛǇǘƛƻƴ ōȅ ŜŘƛǘƛƴƎ ǘƘŜ ǘŜȄǘ ƛƴ ǘƘŜ Description section. 

¶ You can test the link by clicking on the Test/Open button. 

¶ When everything is set to your liking, click on the Accept button. 

 To open or view a document  
¶ Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

¶ To open the document: 

o Right click on the document to invoke a pop up menu. Select the View Document 

ƻǇǘƛƻƴΦ hǊΧ 

o Double click on the document to open it.  
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To edit a document  
¶ Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

¶ Right click on the document to invoke a pop up menu. Select the Edit Document option. 

¶ For the Rich-Text type documents the document will be displayed in the Editor. For the other 

ǘǿƻ ŘƻŎǳƳŜƴǘ ǘȅǇŜǎ ȅƻǳ ǿƛƭƭ ŜŘƛǘ ŀ ŘƻŎǳƳŜƴǘΩǎ ǇǊƻǇŜǊǘƛŜǎ ƛƴ ǘƘŜ ǎŀƳŜ ƳŀƴƴŜǊ ƛǘ ǿŀǎ ŎǊŜŀǘŜŘΦ 

To move or reassign a document to different parent folder  
¶ Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

¶ Right click on the document to invoke a pop up menu. Select the Move to Folder option. 

 
¶ From the Move Document dialog move and select the folder you want to move the document 

to from the displayed tree. 

¶ Once the Folder is selected click on the Move to Folder button. 

To rename a document  
¶ Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

¶ Right click on the document to invoke a pop up menu. Select the Rename Document option. 

¶ From the Rename Document ŘƛŀƭƻƎ ŜŘƛǘ ƻǊ ǊŜƴŀƳŜ ǘƘŜ ŘƻŎǳƳŜƴǘΩǎ ǘƛǘƭŜ ƛƴ ǘƘŜ ǎǇŀŎŜ ǇǊƻǾƛŘŜŘΦ 

¶ Click OK to apply the changes. 

To delete a document  

¶ Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

¶ Right click on the document to invoke a pop up menu. Select the Delete Document option. 

¶ When prompted about deleting the document, click the Yes button. 
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Creating Barcodes and the Designer  
A few of the modules in the system allows for the creation of various barcodes. These barcodes can be 

printed or exported for use with other applications. Barcode creation is supported in the Inventory, 

Assets and Tools Database modules. Work Order and Purchasing documents also use barcodes, but 

these are not user definable and they use the Code39 style. 

To access the barcode routines  

¶ From the Inventory or Assets module ς From the main tab control click on the Options tab. 

Next click on the Barcode tab near the bottom. 

¶ From the Tools Database module. Click on the Details tab followed by the Barcode tab near the 

bottom of the screen 

 

To insert the current Reference ID to be used in the barcode creation:  

¶ Click on the Retrieve Reference button or type the barcode text in the space provided. 

Note the built-in barcode lookups use the Reference fields to find matching criteria 

To access the Barcode Designer: 

¶ Click the Bar Code Designer Button. 

Barcode Designer  
With the Barcode Designer you can specify the type of barcodes to create, specific the barcode text, the 

angle of the barcode, the colors to use, a top caption and more. Please note that not all the 

combinations available will function properly with your system. You may want to experiment a little to 

see what works with whatever scanner you may end up with. The nice thing is that you can create 

various barcodes styles, and even ƛŦ ǘƘŜȅ ŘƻƴΩǘ ŀƭǿŀȅǎ ǿƻǊƪ ǿƛǘƘ ȅƻǳǊ ǎȅǎǘŜƳΣ ȅƻǳ Ŏŀƴ ŀƭǿŀȅǎ ŜȄǇƻǊǘ ǘƘŜ 

images for use with other systems. 
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To create a barcode using the designer  

¶ Move to the Bar Code Type drop down and select the barcode style you want to use. As barcode 

types are selected a Brief Description of the barcode style is shown in the lower left hand 

corner. There are 25 barcode styles to choose from. 

¶ If you want to display the barcode text on the label, checked the Show Text checkbox. 

¶ The Text field is both the text shown above and more importantly the text used to create the 

ŀŎǘǳŀƭ ōŀǊŎƻŘŜΦ CƻǊ ƻǳǊ ǇǳǊǇƻǎŜǎ ǘƘƛǎ ƛǎ ƴƻǊƳŀƭƭȅ ǘƘŜ ǊŜŎƻǊŘΩǎ ǊŜŦŜǊŜƴŎŜ L5Φ 

¶ You can change the angle in which the barcode is shown in the image by changing the Angle 

value. 

 
¶ Fore Color represents the barcode and the text color. Click the down arrow to expand the color 

picker to assign the desired color. 
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¶ Back Color represents the back ground color of the barcode image. . Click the down arrow to 

expand the color picker to assign the desired color. 

¶ You can change the position of the barcode text value by changing the Vertical and Horizontal 

Alignment values 

¶ To show the Top Caption text, check the Show Caption checkbox. 

¶ To edit the Top Caption displayed text, edit the information in the Top Caption ς Text edit box. 

¶ To adjust the Top Caption Alignment change the value in the Top Caption ς Alignment drop 

down list. 

¶ To change the color used by the Top Caption, click the down arrow adjacent to the Top Caption 

ς Fore Color to expand the color picker and then make your selection. 

¶ To apply and see how your settings have affected the barcode image, click on the Apply Barcode 

Settings button.  

¶ To accept the currently designed barcode and apply it to the current record click on the Accept 

button. 

To export the barcode ima ge 

¶ Right mouse click on the image and choose the Export Barcode option. 

¶ Browse to where you want to save the image to, 

¶ Type in a name for the file in the File Name text box. 

¶ Select the image export type by selecting the appropriate value from the Save as type drop 

down. Supported options are bmp, jpg, gif or png. 

¶ Click the Save button. 

To copy the barcode image to the clipboard  
¶ Right mouse click on the image and choose the Copy Barcode option. 

Printing Barcode Labels  
In place of having to buy expensive barcode label printers, this software system supports printing 

directly to either ink jet or laser printers. Also supported are Avery 5262 (6 per sheet), and Avery 8810 

(30 per sheet) compatible labels. The 5262 labels are designed to be used as bin box labels, or for 

directly labeling an asset. We figured that 8810 labels would be small enough to stick to most individual 

items.  

The following illustration shows the element of the Print Labels dialog screen. 
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To print a single barcode label:  

¶ Select the record that contains the label you want to print. 

¶ Ensure that the barcode label has been created and is saved in the database. 

¶ Move to the Reports tab in the ribbon and click on the Print Bar Code option. 

¶ From the invoked Label Printing Setup screen, move to Label Type Selection list and select the 

type of label you wish to print to by clicking on it. If selected properly its description should be 

shown in the lower left hand corner. 

¶ Move to the Label to Print drop down and select the label number to print to. If you are printing 

multiple labels, this label is the starting point of the print job. 

¶ Click on the Accept button to preview the document. 

To print multiple copies of the same label:  

¶ Select the record that contains the label you want to print. 

¶ Ensure that the barcode label has been created and is saved in the database. 

¶ Move to the Reports tab in the ribbon and click on the Print Bar Code option. 
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¶ From the invoked Label Printing Setup screen, move to Label Type Selection list and select the 

type of label you wish to print to by clicking on it. If selected properly its description should be 

shown in the lower left hand corner. 

¶ Move to the Label to Print drop down and select the Print All option. 

¶ Move to the First Label to Print drop and select the starting label to commence printing at. 

¶ Check the All Same (Current Label) checkbox. 

¶ Click on the Accept button to preview the document. 

To print multiple labels from different records:  

¶ Scroll through the database and place a checkmark in the Selected checkbox of each record you 

would like to print a label for 

¶ Move to the Reports tab in the ribbon and click on the Print Bar Code option. 

¶ From the invoked Label Printing Setup screen, move to Label Type Selection list and select the 

type of label you wish to print to by clicking on it. If selected properly its description should be 

shown in the lower left hand corner. 

¶ Move to the Label to Print drop down and select the Print All option. 

¶ Move to the First Label to Print drop and select the starting label to commence printing at. 

¶ Place a check in the Clear Selections checkbox. This will clear selected records so they will not 

be included a second time. 

¶ Ensure that the All Same (Current Label) checkbox is NOT checked. 

¶ Click on the Accept button to preview the document. 

¶ Repeat the above steps until there are no more records selected. 

Lookup Dialog Screens 
There are many Lookup Dialog screens used by the application that were designed for lookup and 

assignment purposes. As these lookups may represent information from different database tables, we 

have tried to design them so they will function in a similar manner regardless of what information or 

table is being presented. 

Also be aware, that not all the functionality of these lookups will always be available to the user. 

hǇǘƛƻƴǎ Ŏŀƴ ōŜ ƘƛŘŘŜƴ ƻǊ ŘƛǎŀōƭŜŘ ōȅ ŀ ǳǎŜǊΩǎ ŀǎǎƛƎƴŜŘ ǊƛƎƘǘǎ ŀƴŘ ŦǊƻƳ ǿƘŜǊŜ ǘƘŜǎŜ ƭƻƻƪǎ ŀǊŜ ōŜƛƴƎ 

activated from. 

The following images outline the common elements of most Lookup Dialogs. The provided illustration 

shows the Parts and Inventory lookup dialog, but the same general features are available to the 

Equipment and Assets, Vendor and Contacts, Mechanics and Employees, and other Lookup dialogs 

screens found in the system. 
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Again, we want to emphasize that depending on the rights being assigned at the time, there will be 

many occasions where these Lookup Dialogs ǿƛƭƭ ŦǳƴŎǘƛƻƴ ŀǎ ΨLookup OnlyΩ type dialogs where the 

controls on the Details tab will be disabled or even invisible. At other times you may be allowed to add 

and edit the information without restrictions. 
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To select a record for insertion or assignment:  

¶ From the Lookup Dialog, move to the Lookup tab. 

¶ To view all currently active records, ensure that the Show Active Only checkbox is checked. To 

view all records uncheck this checkbox. 

¶ If you know a value of one of the fields, you can move to the Filter Row of the column you want 

to filter by. 

¶ Typing in the Filter Row will filter the grid with the criteria you typed in. 

¶ You can also scroll through the records until the one you want is located and selected. 

¶ hƴŎŜ ȅƻǳ ŦƛƴŘ ǘƘŜ ǊŜŎƻǊŘ ȅƻǳΩǊŜ ƭƻƻƪƛƴƎ ŦƻǊΣ ƳƻǾŜ ǘƻ ŀƴŘ ŎƭƛŎƪ ƻƴ ǘƘŜ Select button. 

 

To add a new record using the Lookup Dialog:  

¶ Move to the Data Control and if available click on the plus sign (+) in the control.  

¶ Move to and click on the Details tab. 

¶ Move to the various fields on this tab and edit the information found there. 

¶ Chick on the check (post) button in the data control to save your changes. 

To edit a record (when available):  

¶ Move to the Lookup tab. 

¶ Located and select the record you want to edit from those listed. 

¶ Move to the various fields on this tab and edit the information found there. 

¶ Chick on the check (post) button in the data control to save your changes. 

To delete a record (when available):  

¶ Move to the Lookup tab. 

¶ Located and select the record you want to delete from those listed. 

¶ Click in the minus sign (-) button on the data control, 

¶ Chick on the check (post) button in the data control to save your changes 

Text Editor  
The Text Editor has been installed throughout the system where the user may need to create or edit large 

amounts of text. 

The following elements are found on the Text Editor tab, reading left to right: 
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¶ Save and Close ς Saves the current text back to the call-up control and closes the editor. 

¶ Paste ς Inserts any clipboard text into the document, and at the current cursor location. 

¶ Copy ς Copies selected text and places it into the clipboard. 

¶ Cut ς Deletes selected text and places it into the clipboard. 

¶ Select Allς Selects all the text in the document. 

¶ Find ς Helps to find matching text. 

¶ Find Next ς Helps to find the next match. 

¶ Insert Document ς Inserts a text document saved to file. 

¶ Check Spelling ς Reviews the document checking for spelling errors. 

¶ Cancel and Close ς Closes  the editor without applying any changes. 

Insert Document  

The Insert Document feature works much like the Open Document feature. However, instead of replacing 

the current document, it inserts it at the current cursor location.   

To insert a text document: 

¶ Click in the document where you would like the insertion to occur. 

¶ Click on the Insert Document button in the ribbon. 

¶ Use the File Open Dialog as explained by the current operating system. 

¶ With the file selected, click the Open button. 

Open Document  

If wanted, you can create your text documents in other applications such as Windows Notepad, save the 

file as a text file, and then import it here. 

To import a text file, replacing any currently loaded document: 

¶ Open the File menu. 

¶ Click the Open Document option. 

¶ Use the File Open Dialog as explained by the current operating system. 

¶ With the file selected, click the Open button. 

Save Document 

If wanted you can write text documents using this editor and then save this document to file. 

¶ Open the File menu.. 

¶ Click the Save Document option. 

¶ Use the Save As Dialog as explained by the current operating system. 

¶ Enter a name for your file in the File Name area and click the Save button. 

Print Preview the  Text Document  

To print preview the loaded document: 
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¶ Open the File menu. 

¶ Click the Print Preview option. 

Print Preview   
Just about every module in the system will output some form of a printed document. Sometimes these 

documents can go straight to the default printer, but in almost every case you have the option to 

Preview the documents before actually printing them. The application actually makes use of few 

different preview screens, the most common one of these will be outlined here. 

The following elements are found on the Print Preview ribbon control: 

 

 QUICK ACCESS TOOLBAR 

¶ The first arrow control moves to the first page of the document. 

¶ The second arrow control moves to the previous page. 

¶ The third arrow moves to the next page of the document. 

¶ The fourth arrow moves directly to the last page of the document. 

¶ The printer icon prints the document. 

PRINT PREVIEW TAB 

¶ Open ς Opens a document that was saved to file. 

¶ Save ς Saves the current document to file. 

¶ Reflow ς Redraws the document to screen. 

¶ Print ς Allows you to select the printer to use, and other options prior to printing. 

¶ Page Setup ς Allows you to setup the documents margins, origination and paper types. 

¶ Zoom In ς When clicked, zooms in on the present document. 

¶ Zoom Out ς When clicked, zooms out on the present document. 

¶ Export Options ς Works in the same way as the Save option above. 

¶ Find ς Allows you to search the document for matching text. 

¶ Previous Page ς Moves backwards through the document, one page per click. 

¶ Next Page ς Move forwards through the document, one page per click. 

¶ Close ς Close and exit the Preview Screen. 
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Open Document  

To open a save document: 

¶ Click on the Open option in the ribbon. 

¶ Use the File Open Dialog as explained by the current operating system. 

¶ With the file selected, click the Open button. The following file types are supported: c1dx, c1d, 

c1db and c1mdx. 

Save  or Export Document  

To save or export a document 

¶  Open the File menu. 

¶ Click on the Save or Export Options buttons in the ribbon. 

¶ Use the Save As Dialog as explained by the current operating system. 

¶ Enter a name for your file in the File Name area and click the Save button. 

The following export formats are supported:  Proprietary formats (c1dx, c1d, c1db, and c1mdx), pdf, 

xlsx, xls, rtf, docx, htm, emf, tiff, png, jpg, gif, bmp and xps. 

Print Document  

To print the document: 

¶ Click the Printer icon in the quick access toolbar or click on the Print option in the ribbon. 

¶ From the Print setup the print options to your liking. 

¶ Click the OK button. 

 Page Setup 

The page setup allows you to setup the paper size, source, orientation and page margins. 

To setup the current document: 

¶ Click on the Page Setup button in the ribbon. 

¶ Setup the options on the Page Setup dialog to your liking. 

¶ Click on the OK button. 
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Searching the Document  

You can search the document for matching text by: 

¶ Move to and click on the Find button in the ribbon. This will cause a search dialog to be displayed 

on the right hand side of the Preview screen. 

¶ Move to the Find What text box, and type in the text to search for. 

¶ Place a checkmark in the options you want to apply to your search: 

o Match Case 

o Match Whole Word 

o Search Up 

¶ Click on the Search button.  

To highlight the text that was found, from within the list: 

¶ Click on the item found from the displayed list. 

To close the search panel: 

¶ Click on the Hide button. 
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Email Composer 
The E-mail Composer is for writing and sending e-mails to vendors, other employees, or anyone you so 

choose. You can import saved files with this editor, along with checking your spelling. 

The following elements are found on the Message ǘŀō ƻŦ ǘƘŜ ŎƻƳǇƻǎŜǊΩǎ Ǌƛōōƻƴ ŎƻƴǘǊƻƭΥ 

 

¶ Paste ς Paste the contents of the clipboard into the main body area. 

¶ Cut ς Cuts selected text and stores it in the clipboard. 

¶ Copy ς Copies the selected text and store the copy in the clipboard. 

¶ Recipients ς Allows you select email recipients for the Mail To or CC fields. 

¶ Add Attachment ς Allows you to browse for, and add attachments to the email message. 

¶ View Attachment ς Allows you to open and view the selected attachment. 

¶ Close ς Exits the composer. 
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The following is the image of the Format ǘŀō ƻŦ ǘƘŜ ŎƻƳǇƻǎŜǊΩǎ Ǌƛōōƻƴ ŎƻƴǘǊƻƭΥ 

 

For information on these options we invite you to read the chapter on the Rich Text Editor. 

The following image illustrates the layout of the E-Mail Writer: 

 

Message Recipients 

To add mail recipients to your email message: 

¶ Click on the Recipients button in the ribbon, click on the Mail To button, or click on the CC button. 

¶ Follow the instructions found in the Mail Recipients section of this chapter. 

Message Attachments 

To add attachments such as documents and images to your email message: 

¶ Click on the Add Attachment button in the ribbon, or click on the Attachment button. 

¶ Use the File Open Dialog as explained by the current operating system. 

¶ When the attachment selected, click the Open button. 
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Viewing Message Attachments  

To view or open an attachment: 

¶ Click the down arrow on the Attachments field. 

¶ Click to select the attachment you want to open or view. 

¶ Click on the View Attachment option in the ribbon. 

Message Main Body 

This email writer allows you to create email messages written in the HTML format, which is popular in 

most email applications. To compose your message: 

¶ Move to and start editing your document in Main Body area. 

¶ You can format your document using the options on the Format tab of the ribbon control. 

Sending Your Message 

To send your email message: 

¶ Click on the Send button. 

Saving Your Massage 

You can save the contents of the Message Main Body to file for possible reinsertion at a later time. To 

save the main document to file: 

¶ Compose and format your document to your liking. 

¶ Open the File menu and select the Save or Save As options. 

¶ Use the Save As Dialog as explained by the current operating system. The following file types are 

supported: rtf, txt, htm, html, mht, doc, docx, odt, xml and epub. 

¶ Enter a name for your file in the File Name area and click the Save button. 

Opening a Saved Message 

¸ƻǳ Ŏŀƴ ƛƴǎŜǊǘ ŀ ǎŀǾŜŘ ŘƻŎǳƳŜƴǘ ƛƴǘƻ ǘƘŜ aŜǎǎŀƎŜΩǎ aŀƛƴ .ƻŘȅ ōȅΥ 

¶ Open the File menu. 

¶ Click the Open option. 

¶ Use the File Open Dialog as explained by the current operating system. 

¶ With the file selected, click the Open button. 

0ÒÉÎÔÉÎÇ ÔÈÅ -ÅÓÓÁÇÅȭÓ -ÁÉÎ "ÏÄÙ 

¢ƻ ǇǊƛƴǘ ǘƘŜ ƳŜǎǎŀƎŜΩǎ Ƴŀƛƴ ōƻŘȅέ 

¶ Open the File menu. 

¶ Click on the Print Options button to expand the menu. 

¶ Click on the print option of your choice. 
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Mail Recipients  
The Mail Recipients dialog screen allows you to add and edit the recipients to be used when sending 

emails. This includes the Mail To and in many cases the CC (carbon copy) recipients as well. 

 

To add recipients: 

¶ Move to either the Employees or Vendors/Contractors tab to show the appropriate list of 

possible recipients. 

¶ Click on the record that contains the email address you want to add from those listed. 

¶ Click on either the Mail To or CC buttons to add the selected address to the appropriate field. 

Additional addresses are separated with a semi-color (;). 

¶ If known, you can also type addition email addresses in the spaces provide, separating the 

addresses with a semi-colon. 

¶ When done editing your recipients lists, click on the Accept button. 
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Work Order Wizard  
The Work Order Wizard is accessible from various modules in the system, and will help ease in the work 

order creation by stepping you through the process. Some of the modules supported is the Work and 

Requests module, Issue Tracking modules and the Safety Management module. The Maintenance 

Scheduler module uses its own modified wizard.  

The following illustration shows the general or shared features of the Wizard: 

   

¶ Tab Pages ς This is a logical way of grouping controls by function. 

¶ Previous ς Clicking this button moves you to the previous tab. 

¶ Next ς Clicking the button moves you to the next available tab. 

¶ Save and Close ς Clicking this button saves any changes you may have made, and closes the 

Wizard. 

¶ Cancel ς Clicking this button closes the wizard without applying any changes made. 

Wizard Identification Ta b 
The following illustration shows the elements on this tab: 
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¶ Subject ς This is a brief description of the work order. It can contain up to 100 alpha/numeric 

characters. 

¶ Task ID ς This is generated for you by the program. You are allowed to edit this value, but it is 

not recommended. 

¶ Check ς This checks to ensure that the supplied Task ID is unique in the database. If it was 

generated by the program then is already known to be unique. 

¶ Location ς This specifies the location at which the work order will be performed, and is 

selectable from the drop down list. 

¶ Task Type - There are 7 possible task types available, with 6 of these having user definable titles. 

See the Work Orders Setup section of the Maintenance Scheduler chapter for more 

information.  

Wizard Equipment Tab  
You can assign an unlimited number of assets to a work order. The following image illustrates the 

elements of this section: 
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To assign an asset to the work order: 

¶ Move to the Assigned Assets section and click on the + (plus sign) in the data control found 

there. 

¶ From the invoked lookup dialog, click on the asset record you want to assign. 

¶ Click on the Select button. 

Wizard Requester Tab  
This section allows you to assign the person requesting the work to be performed. 

The following image illustrates the elements of this section: 
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To assign who requested this work order:  

¶ Move to the Requester field and click on the Select button. 

¶ From the invoked lookup dialog, select on the employee you want to assign and click on the 

Select button. 

To allow a Completion Notice to be sent to the requester:  

¶ Check the Send Completion Notice checkbox 

Wizard Work to be Done Tab  
The following illustration shows the elements on this tab: 

 

 

To include work instruction for repair types of work orders  

¶ Move to the Work to be Performed section and edit your instructions in the editor found there. 

You can also click on the Open with Editor button found in this area and use the Repair 

Procedures Editor discussed in the Maintenance Scheduler chapter. 

Wizard ɀ Save and Close 
Whenever you either make changes to work orders, or create a new one with Work Order Wizard, 

ensure to save your changes. 

¶ Click on the Save and Close button to save and apply your changes. 

Spell Checker 
The Spell Checker can be found in the majority of the major editors used by the system. This includes such 

editors as the Rich Text Editor, Text Editor, Tasks Editor and the Email Composer. 
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When the Spell Checker component finds a word that is not contained in the dictionaries associated 

with the current culture, the Spelling dialog can be used for making corrections. This dialog is invoked 

when a spell check is started on demand (for example, when the end-user clicks a button, or the Check 

Spelling item is selected from the context menu, displayed when the end-user right-clicks the incorrect 

word. 

Spell Checker Dialog 

 

This dialog enables the end-user to do one of the following: 

¶ Select one of the suggested corrections to replace the misspelled word (once or all occurrences 

in the text) 

¶ Skip the word (Ignore) 

¶ Ignore the word and all its future occurrences in the text. 

¶ Add the word to a custom dictionary of the Spell Checker (when available).  

The Options... button invokes the Spelling Options Dialog. The Undo button allows cancelling changes, 

step by step. 
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Finding Misspelled Words as you Type  
With some of the editors, misspelled words will be highlighted from within the editor itself. Misspelled 

or unrecognized words will have a wavy red underline below them. When supported, you can right-click 

over these words to invoke a popup menu.  

From this popup you can: 

¶ Replace the word with one of the supplied suggestions. 

¶ Ignore All word with the same misspelling. 

¶ Add the Word to the Dictionary. 

¶ Or invoke the Spell Check Dialog 

The popup may also show other, non-spell checking related options. 
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Budgets 
With the Maintenance Coordinator system you can setup four different types of budgets. The first two 

are based on purchasing and purchase items accounts or cost centers. The other two are based on 

maintenance activities, using maintenance accounts or projects. 
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To setup a budget  

 

¶ Move to the Budget screen. 

¶ Move to the Budget group in the ribbon and click the Add option. 

¶ Move to the Accounting Type list box and select the appropriate option that you want to create 

a budget for. 

¶ Move to the Accounting Year drop down and select the year you want to base your budget on. 

¶ Move to the Budget Category section and click on the Select button found there. 

¶ Choose the appropriate category from the list and click the Select button. 

Editing and Viewing Budgets  

¶ Move to the Budget screen. 

¶ Move to the Budgets section and click on the budget you want to work with from those listed. 

¶ Move to the Budget Work Sheet section and edit the budget amounts found under the BUDGET 

heading. 

¶ To populate the actual amounts you spend on each month, move to the ribbon and click on the 

Retrieve Actuals option. 

¶ To show totals and differences, move to the ribbon and click on the Recalculate Budget option. 

Deleting Budgets  

¶ Move to the Budget screen. 

¶ Move to the Budgets section and click on the budget you want to work with from those listed. 

¶ Open the File menu and select the Remove option. 

¶ Answer Yes to the prompt. 
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3ÅÃÕÒÉÔÙȟ 5ÓÅÒÓȟ $ÁÔÁÂÁÓÅÓ ÁÎÄ 
5ÔÉÌÉÔÉÅÓ 

This chapter deals with security, user accounts, databases and utility modules. Most of features 

described in this chapter are for users with admin rights.  

Logging into the Program  

 

When password protection is active, and when the application first starts up, you'll be greeted with a 

login screen. This login restricts unauthorized users from gaining access, and also sets defaults setups for 

authorized users.  

To login to the program, please follow these steps: 

¶ Start the program in your normal manner. 

¶ When the Login screen appears, move to the User Name text field and type in the name your 

administrator has issued you. 

¶ Move to the Password text field and type in your assigned password. 

¶ Move to and click on the OK button. 
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Re-Logging into the Program  
While the application is already running, you may wish to re-log into the program. There are a couple of 

reasons you may wish to do this. One would be to log in as a different user; the other might be to allow 

different user setup properties to take effect. 

To re-log into the program: 

¶ From the Main Menu screen open the File drop down menu and select the Login as New User 

option. 

 

¶ Login as you would normally. 

Note: When password protection is turned off, this action simply restarts the application. 

Lost or Forgotten Passwords  
If you have lost or forgotten the password to gain access to the program, we have provided a backdoor 

password for emergency use. This password should be kept by your administrator and kept in a secured 

place. This emergency password is the Software Key used to unlock the program, and supplied with 

registered copies of the program.  

To login to the program using the emergency password: 

¶ Start the program in your normal manner. 

¶ When the Login screen appears, move to the Password text field and type in the Software Key 

that was provided you when you purchased the program. 

¶ Click on the OK button. 

Turning Password Protection On and Off  
To toggle password protection either on or off, you must: 
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¶ Log into the program as a user that has Administrator rights. 

¶ From the Main Menu screen open the Admin drop down menu, and then select Users Accounts 

option. 

¶ From the Users Accounts screen click on the File menu and select the Toggle Password 

Protection option. 

¶ A Notice should be provided stating the new protection mode. 

¶ Close the Users Accounts screen. 

The above procedure is used to both turn on and turn off password protection. 

Changing Your Own Password 
Once a user has logged into the program, and password protection is turned on, these users can change 

their own individual password to anything they want. 

For a user to change their password: 

 

¶ Log in to the program as normal. 

¶ Open the File menu and select the Change Your Password option. 

¶ Enter your user name is in the User Name text box. 

¶ Type in your current or old password in the Old Password text box. 

¶ Type in your new password in the New Password text box. 
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¶ Retype your new password in the Confirm Password text box. 

¶ Click on the Apply button. 

¶ A message should be displayed confirming the change. 

User Accounts  
 

With User Accounts you can create an authorized users list where you can assign what system modules 

users have access to. Furthermore you can assign various rights pertaining to what a user can do within 

the modules access has been granted. 

Note: User Accounts assigned rights only apply when password protection mode 

is turned on, also note that password protection is disabled when running a Demo 

version of the software. 

Creating a New User 
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To create a new user: 

1. Start the program in your normal manner. 

2. When the Login screen appears, login as a user with administrator rights. 

3. From the startup Main Menu screen open the Admin drop down menu and then select Users 

Accounts option. 

4. Click on the Add New option in the ribbon or press Ctrl+N. This will provide you a new user 

record to work with. 

5. bƻǿ ŎƭƛŎƪ ƻƴ ǘƘŜ ŜƭƭƛǇǎƛǎ όΧ ύōǳǘǘƻƴ ǘƻ ǘƘŜ ǊƛƎƘǘ ƻŦ ǘƘŜ User Name text field. 

6. Type in the new user's login name in the box provided and clicking the OK button when done. 

 
7. /ƭƛŎƪ ƻƴ ǘƘŜ ŜƭƭƛǇǎƛǎ όΧ ύ ōǳǘton to the right of the User Password text field. 

8. Type in the user's password in the box provided, and click on the OK button when done. 

9. If you want to assign a Personal Database to this user: 

¶ Move to the ribbon and click on the Personal Database option. 

¶ bŜȄǘ ȅƻǳΩƭƭ ōŜ ǇǊƻƳǇǘŜŘ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ǎŜǘ ƻǊ ǊŜǎŜǘ ǘƘŜ 5ŀǘŀōŀǎŜ ŎƻƴƴŜŎǘƛƻƴ ǘƻ ǳǎŜ ŦƻǊ 

this user. Click Yes to continue. 

¶ {Ŝǘ ǳǇ ǘƘƛǎ ŘŀǘŀōŀǎŜ ŎƻƴƴŜŎǘƛƻƴ ŀǎ ƻǳǘƭƛƴŜŘ ƛƴ Χ 

10. If you want to give this user administrator rights, place a checkmark in the System 

Administrator checkbox. 

11. Ensure you click Save Changes in the ribbon to post changes back to the database. 

Setting Individual Module Rights  
Each user can be setup with different user rights to each of the different modules. The rights vary 

somewhat with each module they apply to, and some rights may not apply to certain modules at all. 
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The following is a summary of some of the most common rights, and these can vary between modules.  

 

¶ Administrator Rights - A check here allows the user rights to everything within the list, including 

module access. Please note that checking this option overrides all the other module options, 

checked or not. 

¶ Show Access Button ς ! ŎƘŜŎƪ ƘŜǊŜ ŘƛǎǇƭŀȅǎ ǘƘŜ ƳƻŘǳƭŜΩǎ ŀŎŎŜǎǎ ōǳǘǘon on the main screen. 

This applies even if the user is not granted access rights to the module. 

¶ Allow Module Access - A check here allows the user to access or open the given module. 

¶ Allow Edits (Not Read Only) ς When checked edits are allowed. Unchecked read only mode is 

effectively applied. 

¶ Allow Adding Records - A check here allows the user to add or create new records within the 

module. 

¶ Allow Deleting Records - A check here allows the user to delete or remove records within the 

module. 

¶ Allow Printing ς A check here allows the user to print records and other documents within the 

module. 

¶ Allow Report - A check here allows the user to view and create reports from within the given 

module. 

¶ Allow Saving Main Lookup ς A check here allows the user to save any modification they may 

ŀǇǇƭƛŜŘ ǘƻ ǘƘŜ ƳƻŘǳƭŜΩǎ Ƴŀƛƴ ƭƻƻƪǳǇ ƎǊƛŘΦ hƴŎŜ ǎŀǾŜŘΣ ǘƘŜȅ ǿƛƭƭ ōŜ ǊŜŀǇǇƭƛŜŘ ǘƘŜ ƴŜȄǘ ǘƛƳŜ ǘƘŜ 

module is opened. 

¶ Allow Module Setup ς ²ƘŜƴ ŎƘŜŎƪŜŘ ǘƘŜ ǳǎŜǊ ƛǎ ŀƭƭƻǿŜŘ ǘƻ ŀŎŎŜǎǎ ŀƴŘ ƳƻŘƛŦȅ ŀ ƳƻŘǳƭŜΩǎ 

options and settings. 

¶ Allow Manage Special Fields ς When checked, the user can change user defined fields. 



Maintenance Coordinator 

 

Simplicity Software Technologies Inc | Deleting Users 111 

 

¶ Allow Database Routines - Removing the checkmark here will hide or disable many or all of the 

ƳƻŘǳƭŜΩǎ ōǳƛƭǘ ƛƴ ŘŀǘŀōŀǎŜ ǊƻǳǘƛƴŜǎ ŀƴŘ ƻǇǘƛƻƴǎΦ 

Again, these are just some of the user rigƘǘΩǎ ƻǇǘƛƻƴǎΦ {ƻƳŜ ƳƻŘǳƭŜǎ ǿƛƭƭ ƘŀǾŜ ŀƭƭ ǘƘŜǎŜ ǊƛƎƘǘǎΣ ǎƻƳŜ ǿƛƭƭ 

only have a few of them, and other modules will have completely different ones. 

To set individual module rights: 

¶ Start the program in your normal manner. 

¶ When the Login screen appears, login as an administrator. 

¶ From the Main Menu screen open the Admin drop down menu and then select Users Accounts 

option. 

¶ Use the data control to scroll through the records until you locate the user you want to work 

with. You can also use the grid on the Lookup tab to locate records. 

¶ Move to the Details tab and locate the Module Rights group. 

¶ Move to the Module drop down list and select the module you want to modify the rights on. 

¶ Move to this Assigned Rights list and add or remove checks to each of the available, granting or 

denying rights 

¶ Click on the Save Module Rights button to save the rights for the selected module. 

¶ Repeat the above steps for each module you want to make assignments on. 

Deleting Users  
To delete a user from using the program: 

¶ Start the program in your normal manner. 

¶ When the Login screen appears, login as an administrator. 

¶ Open the Admin drop down menu for the main menu of the program and select the User 

Accounts options. 

¶ Locate the user you wish to delete by using the data control. 

¶ With the user record displayed, move to and click on the delete button  in the quick access 

bar. 

Creating New Databases 
The Maintenance Coordinator program allows you to create new databases for use with the program. 

This feature can prove to be useful when you want to clear data from the program, but not destroy it. It 

will also prove useful when you have multiple users and want a different Personal Database assigned to 

each of your users. 

You can create the following databases using this program: 
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¶ Main Database - This database holds the main information or tables dealing with Maintenance 

Coordinator. Some of the included tables are HR (Employees), Inventory and Parts, Contacts and 

Vendors, Maintenance Documents, Main Programs settings and User Accounts. 

¶ Work Orders Database ς This database hold everything dealing with work orders and PMs. This 

also includes work instructions and time tracking information. 

¶ Purchasing and Receiving Database ς This database maintain information for Purchasing and 

Receiving support, purchase orders, purchase requisitions and blanket purchase orders. 

¶ Personal Manager Database ς This database maintains information on personal items. Personal 

Log, Personal Scheduler, Personal Contacts and Journal information. 

¶ Professional Add-Ons Database ς This database supports some of the add-on features and their 

data storage. Currently supported are Issues and Safety Management information. 

To create a new database, please follow these steps: 

¶ Start the program in your normal manner. 

¶ Log in as an administrator. 

¶ Open the Admin menu and expand the Databases sub-menu. 

 

 

¶ Expand the Create New Database pop-out menu. 

¶ Select the type of database you want create. Options include: 

o New Main Database 

o New Work Orders Database 

o New Purchasing Database 

o New Personal Database 

o New Professional (Add-ons) Database  
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¶ Once the database type is selected, the Save As dialog will appear. 

 
¶ Move to the Save In drop down list box and setup the folder or directory you wish to save your 

new database in. 

¶ Move to the File Name text box and enter the name you want this database to have. Examples 

here could be John, Mark or Lynn for personal databases. 

¶ Click the Save button. 

¶ A message should be displayed saying the operation was successful. 

Setting up Database Connections  
Please refer to the Setting up Database Connections section of the Getting Started chapter for the 

procedures for setting up your database connections. 

Saving and Opening Database Settings 
You can create different database setups to be used at different times. For example, if you use a laptop 

you could have a setup saved for use at home and one for work. 
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To save the current setup  
 

¶ Setup all the connections for all the databases as you would like to save. 

¶ Open the File menu and select the Save Custom Setup option. 

¶ Use this Save As dialog as normally found in Windows. Make the file name something like 

Home, Office or Work, and click the Save button. 

To open a saved setup 
 

¶ Move to the Connection Settings dialog. 

¶ Open the File menu and select the Open Custom Setup option. 

¶ Use the invoked File Open dialog as you would any File Open dialog found in Windows, locating 

the setup file you wish to open. 

¶ Click on the Open button. 
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Opening Different Databases Connections at Startup  
Once you have saved various database connection setups , you can open one of these setups from the 

main menu of the application. This feature can come in handy for a variety of reasons. A couple of good 

examples are when you have database setups for either different clients, or different plant locations. 

To open a saved database setup: 

 

¶ Start Maintenance Coordinator in your normal manner. 

¶ Open the File drop down menu from the main menu of the program, and then choose the Open 

a database Setup option. 

¶ Use this file open dialog to select one of your saved setups. 

¶ Click open and the program will restart with the new setting applied. 

Networking Your Databases  
If you purchased a site or network license you can install or copy your databases to a shared, network 

drive. This way multiple users can access the information stored there at the same time.  

To install and use the databases on a network please refer to the Installing for Network Use section of 

the Getting Started chapter. 
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Import ɀ Export Utility  
The Import-Export Utility was designed to help our clients import information or data from existing 

software packages to ours. You can import from two of the most popular file formats. These include 

Microsoft Access databases and Microsoft Excel spreadsheets. Other options include the ability to open 

and edit information is SQL Server databases, and print the table structures of SQL Databases. 

 

²Ŝ ŘƻƴΩǘ ŜȄǇŜŎǘ ǘƘŀǘ ȅƻǳΩƭƭ ōŜ ŀōƭŜ ǘƻ ƛƳǇƻǊǘ ŀƭƭ ƛƴŦƻǊƳŀǘƛƻƴ ǎǘǊŀƛƎƘǘ ŦǊƻƳ ƻƴŜ ǎƻŦǘǿŀǊŜ ǇŀŎƪŀƎŜ ǘƻ 

another as each company has their own way of doing things. Finding straight one-to-one relationships 

for all information is very unlikely, but we do believe that you should be able to import a great majority 

of the information. This will save you a great deal of time as you ǿƻƴΩǘ ƘŀǾŜ ƛƴǇǳǘ ŜǾŜǊȅǘƘƛƴƎ ŦǊƻƳ 

scratch. 

Accessing the Import ɀ Export Utility  
To access the Import ς Export Utility: 

 

¶ From the main menu of the system, locate and click on the Admin drop down menu. 

¶ Click on the Import ς Export Module option. 
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Navigating Import - Export Utility  
The following outlines the possible options that can be used in the navigation between the components 

of this utility. 

The navigation bar is located on the left side of the screen, and can be used to navigate through the 

components of this module. 

¶ Click on a group within the Navigation Options Bar to branch to 
that component. The groups are the larger of the available items 
shown, with larger text and icons. 

¶ Once a group is expanded, you can click on one of the available 

options to active that option or feature.  

 
You can also use the Main Option menu screen to branch to an 

available feature by clicking on the appropriate button. 

Connecting to a Database 
Every operation provided by this utility requires that you connect to a database and the procedure to do 

this will be outlined here. 

The following illustrates the Set or Select Database Connection dialog that we use to provide database 

connection properties: 

 

To Use an Existing Connection 

¶ Move to drop down list adjacent to the Existing Application Database Connections and select 
the database connection you want to use. These connections are the same ones that are 
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currently setup for main program use. 

 
¶ Ensure that the Use Custom Connection checkmark is not checked. 

¶ Click on the Accept button. 

To Use a Custom Connection 

¶ Move to and check the Use Custom Connection checkbox. 

¶ Click on the Set Connection button. This will invoke the SQL Connection dialog screen as shown 
in the following illustration: 

 
¶ Move to the Sever name drop down box and select the name of your instance of the SQL server 
ȅƻǳΩǊŜ ǳǎƛƴƎΦ LŦ ǘƘŜ ǎŜǊǾŜǊ ƛǎ ƴƻǘ ƭƛǎǘŜŘΣ ǘǊȅ ŎƭƛŎƪƛƴƎ ƻƴ ǘƘŜ Refresh button. 

¶ Move to the Log on to the server group and setup your log on authentication information.  
o Using SQL Express - If you are using the Express database engines as supplied by us, 
ȅƻǳΩƭƭ ǇǊƻōŀōƛƭƛǘȅ ǿŀƴǘ ǘƻ ŎƘŜŎƪ ǘƘŜ Use Windows Authentication option.  

o SQL Server - If you are connecting to full blown SQL Server then complete the SQL 
Server Authentication information. 
Á Check the Use SQL Server Authentication option. 
Á Fill in the User Name and Password fields. 

¶ Next move to the Connect to a database group to connect to the actual database. 
o SQL Server: 

Á Check the Select or enter a database name option. 
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Á Move to the drop down found here and either select or enter the name of the 
database you are connecting to. 

o SQL Express: (Attached database file) 
Á Check the Attach a database file option. 
Á Either use the Browse button here to select the database file, or type in the full path 

to the database (mdf) file in the space provided. 

¶ Test Connection ς Move to and click on the Test Connection button to ensure you have a good 
connect. If it fails, you may want to click on the Advanced button to further define you connection 
properties. 

¶ Click on the Accept button. 

Import Excel Spreadsheet  
The Import Excel Spreadsheet function allows you to import data from an Excel spreadsheet and save 

the information into a SQL Server database.  

To import a spreadsheet: 

¶ Click on the Import Excel Spreadsheet button in the main menu or in the navigation bar. 

¶ Move to Source Spreadsheet group and click on the Browse to Spreadsheet button. 

 
¶ Locate and open the spreadsheet you want to use as the data source by using this familiar File 

Open type dialog.  
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¶ Move to the Destination Database group and click on the Connect to Database button. 

 
¶ Connect to your destination database as described in the Connecting to a Database section of 

this chapter. 

¶ Move to the Table to Copy to drop down list, and select the database table you want to import 

to. All the tables of the connected database should be listed here, and you can only import to a 

single table per import operation. 

 
¶ Move to and click on the Setup Spreadsheet Fields ǘŀō ǘƻ ƳƻǾŜ ǘƻ ǘƘŀǘ ǘŀōΦ hƴ ǘƘƛǎ ǘŀō ȅƻǳΩƭƭ 

setup spreadsheet columns to database columns (fields) relationships. 

¶ Move to an unassigned column of the spreadsheet and click in the header to select the column. 

 
¶ Move to the Database Columns or Fields drop down list and select the field you want to assign 

to the selected spreadsheet column. This assignment indicates the database field the 

spreadsheet column will be imported to. 

Every field or database column assigned to the selected database table will be available in this 

list. 

 
¶ Repeat assigning database columns to spreadsheet columns for each field you want to import. 

Non-assigned spreadsheet columns will be ignored and not imported. Also note that you cannot 

use a database column assignment for multiple spreadsheet columns. 
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¶ Once you have made all the columns to columns relationships, move to and click on the Copy 

Data tab. 

¶ Click on the Copy Data button and wait for the import to complete. 

¶ ²ƘŜƴ ǘƘŜ ƳŜǎǎŀƎŜ ŀǇǇŜŀǊǎΣ ȅƻǳΩǊŜ ŘƻƴŜ ǿƛǘƘ ǘƘŜ ƛƳǇƻǊǘκŎƻǇȅ ǇǊƻŎŜǎǎΦ 

Clear a Column Field Assignment  
To clear a database field assigned to a spreadsheet column: 

¶ Select the spreadsheet column you want to remove the assignment from. 

¶ Click on the Clear Column Field button in the ribbon. 

¶ When prompted about the removal, click on the Yes button. 

Insert a New Blank Column into the Spreadsheet  
To insert a new blank column into the spreadsheet: 

¶ Select a column in the document just after the insertion point of the new column. 

¶ Move to the ribbon and click on the Insert option. 

¶ From the drop down, select the Insert Column to the Left option. 

Insert a New Blank Row into the Spreadsheet  
To insert a new blank row into the spreadsheet: 

¶ Select a row in the document just below the insertion point of the new row. 

¶ Move to the ribbon and click on the Insert option. 

¶ From the drop down, select the Insert Row Above option. 

Delete Rows(s) and Column(s) in the Spreadsheet  
To remove columns or rows from the spreadsheet: 

¶ Select the column(s) or row(s) you wish to delete by clicking its heading.  

¶ Do one of the following: 

o In the Cells group click the Delete button and select the Remove Column(s) or Remove 

Row(s) item from the drop-down list.  

Format Data  
You can format the data in the spreadsheet by: 

¶ Select the cells you want to format the data on. 

¶ Move to the Data Format group and select the format option that you want to apply. Options 

include: 

o Format Text 

o Format Number 

o Format Date 
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Import an Access Database 
The Import Access Database function allows you to copy data from a Microsoft Access database to a 

Microsoft SQL Server Database. You first select and open the source database and a table to copy from, 

and then select the destination database and the table to copy to. Next you setup the field relationships 

of the two databases, then copy. 

To import an Access Database: 

¶ Click on the Import Access Database button in the main menu or in the navigation bar. 

¶ Move to the Databases and Tables tab. Move to the Source Database (Microsoft Access) group 

and click on the Browse to Database button. 

 
¶ Locate and open the database file you want to use as the data source by using this familiar File 

Open type dialog. 

 
¶ Move to the Table to Copy From drop down list and select the database table to use as the 

source table. All tables in the selected database should be listed here. 
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¶ Move to the Destination Database group and click on the Connect to Database button. 

 
¶ Connect to your destination database as described in the Connecting to a Database section of 

this chapter. 

¶ Move to the Table to Copy to drop down list, and select the database table you want to import 

to. All the tables of the connected database should be listed here, and you can only import to a 

single table per import operation. 

 
¶ Move to and click on the Fields to Copy (Setup) ǘŀō ǘƻ ƳƻǾŜ ǘƻ ǘƘŀǘ ǘŀōΦ hƴ ǘƘƛǎ ǘŀō ȅƻǳΩƭƭ ǎŜǘǳǇ 

source columns to destination columns (fields) relationships. 

¶ Move to an unassigned column of the source database and click in the header to select the 

column. 

 
¶ Move to the Database Columns or Fields drop down list and select the field you want to assign 

to the selected source database column. This assignment indicates the database field the source 

database column will be imported to. 

Every field or database column assigned to the selected destination database table will be 

available in this list. 
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¶ Repeat assigning destination database columns to source columns for each field you want to 

import. Non-assigned source columns will be ignored and not imported. Also note that you 

cannot use a database column assignment for multiple source columns. 

¶ Once you have made all the columns to columns relationships, move to and click on the Copy 

Data tab. 

¶ Click on the Copy Data button and wait for the import to complete. 

¶ ²ƘŜƴ ǘƘŜ ƳŜǎǎŀƎŜ ŀǇǇŜŀǊǎΣ ȅƻǳΩǊŜ ŘƻƴŜ ǿƛǘƘ ǘƘe import/copy process. 

Clear a Column Field Assignment  
To clear a database field assigned to a spreadsheet column: 

¶ Select the source database column you want to remove the assignment from. 

¶ Click on the Clear Column Field button in the ribbon. 

¶ When prompted about the removal, click on the Yes button. 

Insert a New Blank Column into the Source Data Grid  
To insert a new blank column into the data grid: 

¶ Select a column in the document just after the insertion point of the new column. 

¶ Move to the ribbon and click on the Insert option. 

¶ From the drop down, select the Insert Column to the Left option. 

Insert a New Blank Row into the Source Data Grid  
To insert a new blank row into the data grid: 

¶ Select a row in the document just below the insertion point of the new row. 

¶ Move to the ribbon and click on the Insert option. 

¶ From the drop down, select the Insert Row Above option. 

Delete Rows(s) and Column(s) in the Spreadsheet  
To remove columns or rows from the data grid: 

¶ Select the column(s) or row(s) you wish to delete by clicking its heading.  

¶ Do one of the following: 

o In the Cells group click the Delete button and select the Remove Column(s) or Remove 

Row(s) item from the drop-down list.  

Open (View) SQL Database 
The Open SQL Database function allows you to open a database and one of its tables. Once opened 

information can be edited directly within the grid, or the data can be exported to an Excel compatible 

file. WARNING: This is a connected database. 

To open a SQL Database: 
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¶ Click on the Open SQL Database button in the main menu or in the navigation bar. 

¶ Move to SQL Database group and click on the Connect to Database button. 

 
¶ Connect to the database as described in the Connecting to a Database section of this chapter. 

¶ Move to the Table to Open drop down list, and select the table that you want to open.  All the 

tables of the connected database will be listed here. 

 
¶ Move to and click on the View Database tab to view and or edit the records of the selected 

table. 

 
¶ Click on Save Changes in the ribbon to apply any changes you have made. 

Editing a Cells Contents 
To edit the text or contents of a record: 

¶ Move to the grid and double click in the cell you want to edit the contents on. Double clicking 

invokes edit mode. 

¶ Type or edit the contents of the cell as wanted. 

¶ Move to the ribbon and click on the Save Changes button to post changes back to the database. 
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To select all records in the Opened Table  
¶ Move to the ribbon and select the Select All option. 

 

To Delete All Selected records in the Opened Table  

¶ Select the rows you want to delete. 

¶ Move to the ribbon and select the Delete Selected Records option. 

¶ When prompted about the deletion, click the Yes button. 

Export Table to Excel  
To export the opened table to Excel: 

¶ Move to the ribbon and click on the Export Data to Excel option. This action will invoke a new 

spreadsheet view of the data. 

¶ Move to the ribbon and again click, Export to Excel. This will invoke the Save As dialog screen. 

¶ From the invoked Save As dialog, browse to and select the folder you wish to save the file in. 

¶ Move to the File name text box and type in a name for the file. 

¶ Click on the Save button. 

¶ Click on the Close button. 

Printing Database Field Definitions  
You can print the field definitions for tables in your database. This information can come in handy for 

such things as creating records. 

To print field definitions: 

¶ Click on the Print Database Field Definitions button in the main menu or in the navigation bar. 
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¶ From the invoked Print Database Field Definitions dialog move to the Database Connection 

group and click on the Connect to Database option. 

 
¶ Connect to the database as described in the Connecting to a Database section of this chapter. 

¶ Move to the Table to Print drop down list, and select the database table you want to print 

information on. All the tables of the connected database should be listed here. 

 
¶ Click on the Print Column Definitions ōǳǘǘƻƴΦ ¢Ƙƛǎ ǿƛƭƭ ǎƘƻǿ ŀ ǇǊƛƴǘ ǇǊŜǾƛŜǿ ƻŦ ǘƘŜ ǘŀōƭŜΩǎ ŦƛŜƭŘǎ 

or columns. 

 
¶ Click Close when done. 
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7ÏÒË ÁÎÄ 2ÅÑÕÅÓÔÓ -ÏÄÕÌÅ 

¢Ƙƛǎ ƳƻŘǳƭŜ ǿŀǎ ǇǊƛƳŀǊƛƭȅ ŘŜǎƛƎƴŜŘ ŦƻǊ ǳǎŜ ŀǎ ŀ ΨWork RequestsΩ module where the users only needs to 

fill out the information on a single page in the creation of new work requests. As this is already 

considered a very simple process, you can also use a Work Order Wizard that simplifies the process 

even further. 

 

This module is designed for use with standard work orders, which includes 6 types with user definable 

titles, and one fixed, Standard Work Order type. We believe you'll find this module much easier to use 

for these types of work orders than the Maintenance Scheduler module. With that said however, the 

system power users, or administrators would normally want to use the Maintenance Scheduler module. 

The Maintenance Scheduler module can handle all work order types available and provides many 

additional features over this module, and overall is considered more powerful. 

You also want to use the Maintenance Scheduler module to add items, such as Classification 

assignments, Projects and the like to the database for use with both of these modules. You can setup 

and customize the work order print settings with the Maintenance Scheduler module, along with the 

custom user defined titles. 

All works orders when first created are assigned a status of Work Requests. Your system coordinator 

needs to only sort the database by this status to quickly find all work requests. He can then perform 

whatever action he wants with these tasks. 
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Ribbon Control  
The comprehensive functionality of the Work and Request module is provided via a set of Ribbon tabbed 

pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

WORK ORDERS TAB 

 

The following are the elements on the Work Orders ribbon tab, reading left to right: 

¶ Add New ς Creates a new work order document through the use of a wizard, or directly on 

screen. 

¶ Save Changes ς Saves all current changes from all elements of a record (master save). 

¶ Print Work Order ς Allows selecting a printer, number of copies, etc. prior printing the current 

work order. 

¶ Print Preview ς Provides a print preview for the selected work order. 

¶ Filter Wizard - Launches the Custom Filter Wizard dialog that allows specific criteria to be setup 

to filter the database by. Please refer Main Report ς Filter Wizard section in this chapter. 

¶ Filter by Requester - Filters the database by a selectable, assigned employee as it applies to 

wŜǉǳŜǎǘŜǊΩǎ ŦƛŜƭŘΦ    

¶ Default Filter ς Re-filters the database by default values (all open). 

¶ Main Report Wizard - This report uses a Wizard that allows the user to setup the criteria to use 

for the report creation. Please refer Main Report ς Filter Wizard section in this chapter. 

¶ Search - Invokes the search/find routine on the Lookup Grid. 

FILTERS TAB 

 

The following are the element of the Filters ribbon tab, reading left to right: 

¶ Mechanic Assignment - Filters the database by a selectable, assigned mechanic or employee.   

¶ Mechanic Today - Filters the database by a selectable, assigned employee with work orders with 

a scheduled start date of today. 
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¶ Asset - Filters the database by a selectable, assigned asset. 

¶ All Open ς CƛƭǘŜǊǎ ǘƘŜ ŘŀǘŀōŀǎŜ ōȅ ŀƭƭ ǿƻǊƪ ƻǊŘŜǊǎ ǘƘŀǘ Řƻ ƴƻǘ ƘŀǾŜ ŀ ǎǘŀǘǳǎ ƻŦ Ψ/ƻƳǇƭŜǘŜŘΩΦ 

¶ Work Requests ς Filters the database to view only those records with a status of Work Request. 

¶ Past Due ς Filters the database by all records with a scheduled completion date prior to today, 

and a status of still being open. 

¶ Show All- Shows all work orders regardless of status. 

¶ Classifications Assignments ς Filters the database by a selectable, assigned classification.     

¶ Filter by Location ς Filters the database by a selectable, assigned location. 

Features of the Work Requests Module  
There are many features of the Work and Requests module, with the majority of these features found 

on either the tabbed pages found there, or within the tabbed ribbon control. We are going to explain 

the use of these features as we move through the tabbed pages. 

Lookup Tab  
This tab helps in locating work orders by grouping, filtering and sorting them. All the work orders in the 

current filter are located in the grid found there. To select a work order and make it the active record, 

the user needs only to click on the work order from within the grid. Once selected the user can click on 

the other tabs to view or edit the work order itself. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Pay special attention to the following: 

¶ Using the Lookup Grids 

¶ Searching 
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¶ Scanned Lookups (Barcodes Support) 

Details Tab  
Under the Details tab you can setup your scheduling information, equipment, classification assignments, 

labor resources and other work order specifics. 

Work Order Identification  
This section allows you to specify a subject for your work order, a task ID, and the location to be used in 

the execution of the work order. 

The following image illustrates the elements of the section: 

 

Subject 
This field can contain up to 100 alpha/numeric characters. Used for identification purposes, this should 

provide a brief description of the work order as it relates to the work to be performed. 

Task ID 
This field can contain up to 20 alpha/numeric characters and is normally created for you by the 

application.  It uses the following format: YYMM-###, where YY is the year of work order creation, MM 

for the month of creation, and ### a sequential number. 

If wanted, this field can be overwritten, but this is not advised. Also having a unique ID is not enforced. 

However, to verify that it is unique you can click on the Check button adjacent to this field. 

Location  
This field can contain up to 50 alpha/numeric characters and is used to describe the physical location of 

where this work order is to be performed. 

Created 
This is set when a new work order is created. 

Assigned Assets 
You can assign an unlimited number of assets to a work order. However, only one of these will be used 

as the Primary Asset. Most of the available reports will be based on the Primary assignment. 
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The following image illustrates the elements of this section: 

 

To assign an asset to the work order:  

¶ Move to the Assigned Assets section and click on the Append (+) button in the data control 

found there. 

¶ From the invoked lookup dialog, click on the asset record you want to assign. 

¶ Click on the Select button. 

¶ Click the Post (check) ōǳǘǘƻƴ ƛƴ ǘƘŜ !ǎǎŜǘǎΩ Řŀǘŀ ŎƻƴǘǊƻƭ ǘƻ ǎŀǾŜ ȅƻǳǊ ŎƘŀƴƎŜǎΦ 

To set which asset to assign as the primary asset:  

¶ Click on the asset you want to assign from those listed. 

¶ Click the Set Primary Asset button.  

¶ Click Yes to the prompt about setting the primary asset. 

¶ The asset should be displayed in the Primary Asset field. 

To remove an asset from the current work order:  

¶ Click on the asset you want to remove from those listed. 

¶ Click on Remove (minus sign) buǘǘƻƴ ƛƴ ǘƘŜ !ǎǎŜǘǎΩ Řŀǘŀ ŎƻƴǘǊƻƭΦ 

¶ When prompted about the removable, click on the Yes button. 

¶ Click the Post (checkmark) ōǳǘǘƻƴ ƛƴ ǘƘŜ !ǎǎŜǘǎΩ Řŀǘŀ ŎƻƴǘǊƻƭΦ 

To use the Auto Subject feature in this section:  

¶ Click on the Auto Subject button found in this area. 

¶ When prompted about accepting this new Subject title, click OK. 

The auto subject feature combines the assigned work order type with information about the assigned 

primary asset to create a Subject title for the current work order, replacing any existing title. 

Work Order Settings  
The section allows you to setup the Task Type of the work order, the priority indicator, and the 

estimated downtime. 

The following image illustrates the elements of the section: 
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Task Type (Work Order Type Assignment)  
There are 7 possible task types available, with 6 of these having user definable titles. See the Work 

Orders Setup section of the Maintenance Scheduler chapter for more information.  

To assign a Task Type to your work order: 

¶ Click on the down arrow attached to this field. 

¶ Click on the value you want to assign from those listed. 

Priority  
You can assign your work orders a priority indicator. Options include: Urgent, High, Normal and Low. 

To assign a Priority to your work order: 

¶ Click on the down arrow attached to this field. 

¶ Click on the value you want to assign from those listed. 

Estimated Down Time  
You can record the estimated time you feel will be needed to completed a work order. This information 

shows on the work order itself, and can be used with reports. 

To assign the Estimated Downtime for your work order: 

¶ Click on the down arrows adjacent to the HRS and MINS fields. 

¶ Click on the value that you want to assign from those listed. 

Work Requested By  
This section allows you to specify who requested this work to be performed. 

The following image illustrates the elements of this section: 
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To assign who request this work order:  

¶ Move to the Work Requested By group and click on the Select button. 

¶ From the invoked lookup dialog, select the mechanic you want to assign and click on the Select 

button. 

To email the requester:  

¶ Move to the Work Requested By group and click on the Open button 

Work to Be Performed  
This section allows you to create tasks instructions to be used with Repair types of work orders. The 

following illustration shows the elements of this section. 

 

To edit repair instructions or comments  
¶ Select the work order you want to edit instructions for. 

¶ Move to the Details tab. 

¶ Move to the Work to be Performed group. 

¶ Perform one of the following: 

o Type in your instructions or comments in the editor found there. 

o Click on the Open with Editor to edit your instructions or comments with the invoked 

Repair Procedures Editor, clicking on the Save and Close button in the ribbon when 

done. 

For more information on the editor, please refer to the Repair Procedures Editor in the Maintenance 

Scheduler chapter.  
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To use the Auto Subject feature in this section:  

¶ Click on the Auto Subject button found in this area. 

¶ When prompted about accepting this new subject title, click OK. 

This auto subject is based on the Work to be Performed text as entered in the section editor. 

Administrator Tab  
The Administrator Tab does not need to be accessed by the person requesting work to be done. They 

really only need to fill in the information on the Details tab. Your system administrator would use this 

tab to accept and make assignments for the work order. 

Work Order Scheduling  
This area sets up the work order scheduling criteria.  

The following image illustrates the elements of this section: 

 

Start Date and Time  
These values would indicate the Scheduled date and time you would like work to commence on the 

work order. 

To set these values: 

¶ Click on the down arrows attached to these fields. 

¶ Click the value you want to use from the drop down list. 

End Date and Time 
These values would indicate the Scheduled date and time you would like work to be completed by. 

To set these values: 

¶ Click on the down arrows attached to these fields. 

¶ Click the value you want to use from the drop down list. 

Assignments  
This section allows you make some general type assignment to your work order. These assignments help 

with the creation of reports. 
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The following image illustrates the elements of this section: 

 

To make the assignments in this section: 

¶ aƻǾŜ ǘƻ ǘƘŜ ŀǇǇǊƻǇǊƛŀǘŜ ŦƛŜƭŘ ǿƛǘƘ ŜƭƭƛǇǎŜ όΧύ ōǳǘǘƻƴǎ ŀƴŘ ŎƭƛŎƪ ƻƴ ǘƘŜ ōǳǘǘƻƴΦ 

¶ From the invoked lookup dialog, move to the grid and click on the record of your choice. 

¶ Click on the Select button. Or 

¶ Move to the appropriate field and click on the down arrow on the drop down list. 

¶ Make your selection by clicking on it. 

Work Order Status  
The following illustrates the elements found in this section: 

 

To change the Status of the current work order  

¶ From the Administrator tab, move to the Work Order Status group. 

¶ Select the status indicator your want to assign from the drop down list. Available options 

include: 

o New Request 
o Waiting Approval 
o Waiting on Parts 
o Waiting on Labor 
o Waiting on Production 
o Waiting on Contractor 
o On Hold (General) 
o Ready 
o In-Progress 
o Completed 
o Disapproved 
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¶ Move to the % Completed field to record this information. 
 
 

To Send Status to Requester 

¶ From the Administrator tab, move to the Work Order Status group. 

¶ Click on the Send Status to Requester button. 

¶ When prompted about sending the email, click Yes. 

Work Order Completion Information  
This section allows you to record completion information as it relates to the currently selected work 

order.  

The following illustrates the elements found in this section: 

 

¶ Date Completed ς Use the drop down calendar adjacent to this field to set the date the work 

ƻǊŘŜǊ ǎǘŀǘǳǎ ǿŀǎ ŎƘŀƴƎŜŘ ǘƻ Ψ/ƻƳǇƭŜǘŜŘΩΦ 

¶ Completed By ς Use the Select button adjacent to this field to assign an employee to this field.  

¶ Inspected By ς Use the Select button adjacent to this field to assign an employee to this field.  

¶ Meter Value ς This field would indicate the meter value, if applicable, of the primary asset at 

the time the work order was completed.  

¶ Get Current ς /ƭƛŎƪƛƴƎ ǘƘƛǎ ōǳǘǘƻƴ ǿƛƭƭ ŎŀǳǎŜ ǘƘŜ ǇǊƻƎǊŀƳ ǘƻ ǊŜŀŘ ǘƘŜ tǊƛƳŀǊȅ !ǎǎŜǘΩǎ ǊŜŎƻǊŘ ŀƴŘ 

retrieve its current meter value and insert it in to the Meter Value field. 

¶ Actual Down Time ς Use the Hours and Minutes fields found here to record the actual time it 

took to complete the selected work order. 

¶ Save to History ς Clicking this button will save a summary of the completed work order to 

tǊƛƳŀǊȅΩǎ !ǎǎŜǘ IƛǎǘƻǊȅ [ƻƎΦ 

Completion Notes and Delays  
Use the editor found in this area to record any information as it applies to completion notes and delays. 

You can also click on the Open with Editor button to edit this information with a text editor. 
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Add New Work Order  
To add a new work order: 

 

¶ Move to the Work and Requests module. 

¶ Move to the Work Orders tab in the ribbon and click on the Add New button. 

¶ When prompted about the operation, click on the response of your choice. 

o Yes ς Launches the Work Order Wizard that steps you through the creation process. 

This wizard will be explained later in this chapter. 

o No ς Creates a new work and returns you to the Details tab where you can move 

through the fields editing and adding information as necessary. 

o Cancel ς Backs out of the creation process. 

Save Changes 
To save changes to the main work order record, click on the Post (V check) button in the Data Control 

ƭƻŎŀǘŜŘ ǿƛǘƘƛƴ ǘƘŜ ǊƛōōƻƴΩǎ Quick Access toolbar. 

To save changes to the main work order record and all the underlying records (assets, etc.), click on the 

Save Changes button found on the Work Orders tab of the ribbon control. 
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Export the Current Work Order  
To export the currently selected work order: 

¶ Select the work order you want to export. 

¶ Open the File menu and select the Export Work Order option. 

¶ Browse and select the folder you want to export to. 

¶ Type in a name for the export file in the File name text box. 

¶ Move to the Save as type drop down and select the export file type of your choice. 

¶ Click the Save button. 

Printing the Current Work Order  
To print the current work order: 

¶ Open the File menu and expand the Print sub-menu by clicking on it. 

¶ Select the print option of your choice. 

Work Order Wizard  
The Work Order Wizard when accessed from this module will help ease in the work order creation by 

stepping you through the process. This wizard is also accessible from the Issues Tracking Modules, 

Safety Management and the Personal Manager. 

The following illustration shows the general or shared features of the Wizard: 

   

¶ Tab Pages ς This is a logical way of grouping controls by function. 

¶ Previous ς Clicking this button moves you to the previous tab. 

¶ Next ς Clicking the button moves you to the next available tab. 
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¶ Save and Close ς Clicking this button saves any changes you may have made, and closes the 

Wizard. 

¶ Cancel ς Clicking this button closes the wizard without applying any changes made. 

Wizard Identification Tab  
The following illustration shows the elements on this tab: 

 

¶ Subject ς This is a brief description of the work order. It can contain up to 100 alpha/numeric 

characters. 

¶ Task ID ς This is generated for you by the program. You are allowed to edit this value, but it is 

not recommended. 

¶ Check ς This checks to ensure that the supplied Task ID is unique in the database. If it was 

generated by the program then is already known to be unique. 

¶ Location ς This specifies the location at which the work order will be performed, and is 

selectable from the drop down list. 

¶ Task Type - There are 7 possible task types available, with 6 of these having user definable titles. 

See the Work Orders Setup section of the Maintenance Scheduler chapter for more 

information.  

Wizard Equipment Tab  
You can assign an unlimited number of assets to a work order. The following image illustrates the 

elements of this section: 
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To assign an asset to the work order: 

¶ Move to the Assigned Assets section and click on the + (plus sign) in the data control found 

there. 

¶ From the invoked lookup dialog, click on the asset record you want to assign. 

¶ Click on the Select button. 

Wizard Requester Tab  
This section allows you to assign the person requesting the work to be performed. 

The following image illustrates the elements of this section: 
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To assign who requested this work order:  

¶ Move to the Requester field and click on the Select button. 

¶ From the invoked lookup dialog, select on the employee you want to assign and click on the 

Select button. 

To allow a Completi on Notice to be sent to the requester:  

¶ Check the Send Completion Notice checkbox 

Wizard Work to be Done Tab  
The following illustration shows the elements on this tab: 

 

 

To include work instruction for repair types of work orders  

¶ Move to the Work to be Performed section and edit your instructions in the editor found there. 

You can also click on the Open with Editor button found in this area and use the Repair 

Procedures Editor discussed in the Maintenance Scheduler chapter. 

Wizard ɀ Save and Close 
Whenever you either make changes to work orders, or create a new one with Work Order Wizard, 

ensure to save your changes. 

¶ Click on the Save and Close button to save and apply your changes. 
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Main Report ɀ Filter Wizard  
This Wizard is used or both the Filter Wizard and Main Report Wizard of the Work and Request Orders 

module. When used for either filtering or reporting purposes, the resulting items will be returned by the 

choices or criteria as setup with this wizard. 

Types and Status tab 
The following illustrates the elements found on this tab: 

 

¶ Work Order Types ς This drop down allows for the selection of the types of work orders to be 

included. Make your selection by clicking on an item in the drop down list. 

¶ Work Order Status ς This drop down allows for the selection of the work orders status indicator 

to be included. Make your selection by clicking on an item in the drop down list. 

Assignments tab  
The following illustrates the elements found on this tab: 
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¶ To assign values to these fields: 

o Move to the appropriate fields and click on the Select button adjacent to them. 

Available options include: 

Á Requester 

Á Classifications 

Á Locations 

Á Projects 

Á Assets/Equipment 

Á Mechanic (Employee) 

o From the invoked dialogs, move to the displayed grid and click on the record of your 

choice. 

o Click on the Select button.  

¶ To clear the assignments: 

o Move to the appropriate field and click on the Use All button adjacent to them. 
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Dates and Sorting Tab 
The following illustrates the elements found on this tab: 

 

To assign date values: 

¶ Move to the Start Date field and using the drop down calendar, select the starting date of your 

filtering criteria. 

¶ Move to the End Date field and using the drop down calendar, select the ending date of your 

filtering criteria. 

¶ To ignore or use all available dates, check the Use All Dates checkbox. 

¶ To use completion dates, place a checkmark in the Use Completion Dates checkbox. Otherwise, 

Scheduled Start Dates will be used. 

¶ Move to the Sort By drop down, and select how you want things sorted by. 

¶ With everything setup as wanted, move to and click on the Accept button. 

Main Report Wizard  
This report uses the Main Reports ς Filter Wizard for the creation of report criteria.  Please refer to the 

Main Reports ς Filter Wizard section of this chapter for more information. The only elements of this 

wizard that is not explained with this wizard is outlined next. 

These options are found on the Dates and Sorting tab of the wizard. 
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¶ Include Task Instructions ς When checked, the report will include all task instructions as 

assigned to each of the reported work orders. 

¶ Include Delays and Completion Comments ς When checked, the report will include all Delays 

and Completions comments that were recorded for each of the reported work orders. 

To create a Work Orders Summary Report: 

¶ Move to the Work Orders tab in the ribbon.  

¶ Click on the Main Report Wizard option. 

¶ Follow the instructions as outlined in the Main Reports ς Filter Wizard section of this chapter.  

The following illustration shows a preview of a Work Orders Summary Report: 
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-ÁÉÎÔÅÎÁÎÃÅ 3ÃÈÅÄÕÌÅÒ  

The Maintenance Scheduler ƳƻŘǳƭŜ ƛǎ ǘƘŜ ƘŜŀǊǘ ƻŦ ŀƭƭ /aa{ ǘȅǇŜ ǇǊƻƎǊŀƳǎΣ ŀƴŘ ȅƻǳΩƭƭ Ŧind ours to be 

extremely powerful, feature rich, and easy to use. The Maintenance Scheduler module was designed to 

handle all work order types. These include recurring and one time, or repair types of work orders. 

 

One of the most valuable features of this module is found in its ability to create and use recurring work 

order type tasks. Once a work order has been setup, the program will handle the responsibility of 

keeping track of when the work order is next due to be performed, and will schedule it accordingly, and 

automatically as the module is opened. 

This module also accommodates for the easy creation of reports, and when possible, it employs the use 

of report wizards. With the wizards you can create some fairly custom reports, specifying the criteria 

needed for the report creation. These reports will allow you to view and analyze information in a way 

that is right for you and your organization. 

The system supports 5 recurring work order types, 4 of these have user definable titles. There are 7 

standard, or repair types of work orders, with 6 of these having user defined titles. Out of these 11 work 

order types, 2 are designated as Contractor/Vendor types, with 1 belonging to the repair, one-time 

group, and the other one belonging to the recurring, PM types group. 

  



Maintenance Coordinator 

 

Simplicity Software Technologies Inc | Printed Work Order Documents 150 

 

Printed Work Order Documents  
The next illustration outlines the elements on a printed work order document. Most of these elements 

can be turned on or off and further customized through the Work Orders Setup.  
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Work Orders Setup  
The Scheduler module allows you to setup various options for use with this and the Work Requests 

modules. This includes elements on the printed documents, view options, and other general features. 

To access the Work Orders Setup screen: 

 

¶ Move to the Main Scheduler. 

¶ Click on the File button in the ribbon and click the Work Orders Setup option. 

General Tab 
This tab allows you to specify the following options: 

GLOBAL SETTINGS 

¶ Next Work Order Number -The number here specifies the next sequential number to use in the 

automatic work order number generation. These numbers use the following format: yymm ς xx. 

Where yy equals the year of task creation, mm equals the month of task creation, and xx is a 

sequential number. 

¶ Days in Advance to Generate Work Orders - To help keep the database at a reasonable size, we 

allow you to specify how many days in advance to generate or display work orders. 

¶ Work Order Types - Document Control Number: This is the ISO document control number you 

want to assign to repair types of work orders. 

¶ PM Types - Document Control Number - This is the ISO document control number you want to 

assign to recurring types of work orders. 
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¶ Do No Generate New Work Orders for Weekends - Selecting this option will prevent new work 

works from being scheduled on weekends. If it does fall on a weekend, it will be moved to the 

following Monday. This applies to auto recurring work orders only. 

¶ Generate New Work Orders for In-service Equipment Only - Selecting this option prevents the 

automatic creation of new work orders when the assigned equipment record has not been 

placed in service. Please refer to the Equipment and Assets chapter for more information. 

¶ Default Times: !ƭƭƻǿǎ ȅƻǳ ǘƻ ǎŜǘǳǇ ǘƘŜ ŘŜŦŀǳƭǘ Ψ{ŎƘŜŘǳƭŜŘΩ Start and End Times to be used as 

new work orders are created. Change the values by selecting new values from the drop down 

lists. 

 

LOCAL SETTINGS 

¶ Allow the Automatic Printing of Work Orders - Selecting this option allows a notice to popup 

when you first open the program. This will notify you about work orders due today, and gives 

you the option to print them from the pop up. 

¶ Allow Work Order Reminders - Allows the pop ups reminding of upcoming work orders. 

¶ Allow Past Due Notification of Work Orders: Selecting this option allows a popup to be 

displayed when you first enter the Maintenance Scheduler module. This signals the user about 

work orders that are still open, but the scheduled completion dates have past. You then have 

the option of filtering the database by only past due work orders. 

NOTE: Global Settings are applied throughout the system, and from wherever the application is 

running from. Local Settings on the other hand only apply to the local computer from where these 

settings were made. 
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Recurring PM Types Tab 
This tab allows you to setup the Work Type Titles to be used for recurring, or PM types of work orders. 

¸ƻǳ Ŏŀƴ ǎǇŜŎƛŦȅ ǘƘŜ ŎƻƭƻǊǎ ǘƻ ōŜ ǳǎŜŘ ōȅ ǘƘŜ ǇǊƛƴǘŜŘ ŘƻŎǳƳŜƴǘǎΩ ǎŜŎǘƛƻƴ ƘŜŀŘŜǊǎΦ ¢ƻ ŎƻƴǎŜǊǾŜ ƛƴƪ ǿƛǘƘ 

these documents we suggest using a light, or even a white/clear color. 

 

To change a Title 

¶ Edit the displayed title to your liking. 

To setup the colors to use  

¶ Click on the down arrow adjacent to the task Work Order type you want to setup. 

¶ Select the color of your choice by clicking on it. 

One-Time WO Types Tab 
This tab allows you to setup the Work Type Titles to be used for one-time, or repair types of work 

ƻǊŘŜǊǎΦ ¸ƻǳ Ŏŀƴ ǎǇŜŎƛŦȅ ǘƘŜ ŎƻƭƻǊǎ ǘƻ ōŜ ǳǎŜŘ ōȅ ǘƘŜ ǇǊƛƴǘŜŘ ŘƻŎǳƳŜƴǘǎΩ ǎŜŎǘƛƻƴ ƘŜŀŘŜǊǎΦ ¢ƻ ŎƻƴǎŜǊǾŜ 

ink with these documents we suggest using a light, or even a white/clear color. 

To change a Title 

¶ Edit the displayed title to your liking. 

To setup the colors to use  

¶ Click on the down arrow adjacent to the task Work Order type you want to setup. 

¶ Select the color of your choice by clicking on it. 
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PM Print Elemen ts Tab 
Select the options on this tab that you want printed on your recurring types of work order documents. A 

checkmark indicates the item will be printed. Removing the checkmark will prevent printing. 

 

With the Material List, Completion Information (Sign-offs) and Recording of Completion Steps sections, 

you have the ability to print 1 to multiple lines of information for the purpose of recording this 

information. 

To specify the number of lines to print on the documents: 

¶ Move to the Spin buttons adjacent to these fields and near the # of Lines area. 

¶ Using the Up or Down arrows, adjust these values to the number of lines you want printed. 

WO Print Elements Tab  
Select the options on this tab that you want printed on your recurring types of work order documents. A 

checkmark indicates the item will be printed, removing the checkmark prevent the item from printing. 

With the Material List, Completion Information (Sign-offs) and Recording of Completion Steps sections, 

you have the ability to print 1 to multiple lines of information for the purpose of recording this 

information. 

To specify the number of lines to print on the documents: 

¶ Move to the Spin buttons adjacent to these fields and near the # of Lines area. 
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¶ Using the Up or Down arrows, adjust these values to the number of lines you want printed. 

 

User Fields Tab 

 

This tab allows you to setup the following elements: 

¶ Use User Defined Fields ς Placing a checkmark here will cause the user-defined fields to show 

up on the printed document. 
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¶ Work Orders User Defined Fields ς ¢Ƙƛǎ ŀƭƭƻǿǎ ȅƻǳ ǘƻ ǎǇŜŎƛŦȅ ǘƘŜ ŘŜŦŀǳƭǘ ǳǎŜǊ ŘŜŦƛƴŜŘ ŦƛŜƭŘǎΩ 

titles that will be filled in for you when a new work order is created. You can change these on 

the original work order at any time after the creation process is completed. 

¶ Use Custom Comments ς Placing a checkmark here will cause the program to use your custom 

Comments Section title. Leaving this unchecked will cause the program to use its own built in 

ǘƛǘƭŜ ƻŦ ά/ƻƳƳŜƴǘǎέΦ 

¶ Custom Title - Here you would specify the custom title you would like to use for the Comments 

field of PM types of work orders. 

Email Tab  
The Email tab allows you to enable New Work Orders Notices to be sent, who to send these notices to, 

and enable the use of Completion Notices.  

 

To enable a notice to be sent as new work orders are entered into the system: 

¶ Check the Allow New Work Request Notices check box. 

To add mail recipients for use with the New Requests routine: 

¶ Move to and add the email addresses in the Recipients Email Addresses text box, Separate 

multiple addresses with a semi-colon (;). 

¶ You can also use the lookup routine to add recipients by clicking on the Select button found in 

this area. 
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To allow Completion Notice to be sent to the Requester: 

¶ Check the Allow Completion Notice to Originator check box. 

Ribbon Control  
The comprehensive functionality of the Main Scheduler is provided via a set of Ribbon tabbed pages. 

Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

¶ Add New ς Creates a new work order document through the use of a wizard, or directly on 

screen. 

¶ Save Changes ς Saves all current changes from all elements of a record (master save). 

¶ Refresh ς Re-reads the databases and returns new or changed information. 

¶ Generate Today ς Shows all work orders scheduled to start today and allows printing these 

work orders. 

¶ Generate Options 

o Generate by Dates ς Allows you to view and print all work orders that fall with a date 

range. 

o Generate by Classification - Allows you to view and print all work orders that fall within 

a date range and has a specific classification assignment. 

o Generate by Location - Allows you to view and print all work orders that fall within a 

date range and has a specific location assignment. 

¶ Mail Work Order ς Opens the Email Composer with current work order as an attachment. 

¶ Search ς Invokes the search routine on the Lookup Grid as explained in the Common Features 

chapter. 

¶ Exit ς Close the Maintenance Scheduler module. 
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WORK ORDERS TAB 

 

The following are the elements found on the Work Orders tab: 

¶ Materials ς Allows you to assign and track inventory items needed and used for the work order 

completion. 

¶ Work Labor ς !ƭƭƻǿǎ ȅƻǳ ǘƻ ŀǎǎƛƎƴ ƳŜŎƘŀƴƛŎǎΩ ŜǎǘƛƳŀǘŜŘ ŀƴŘ ŀŎǘǳŀƭ ǘƛƳŜǎ ƴŜŜŘŜŘ ƛƴ ǘƘŜ ǿƻǊk 

order completion. 

¶ Time Tracker ς Allows the use of a stop watch type function to record a mechanics time working 

on a work order. Also allows for the creation of Time Card type reports. 

¶ Recur ς Provides options for recurring work order types. 

o Set Next Meter ς Allows you to specify the meter value of the Primary Asset to reach, 

for the current work order to become due. 

o /ƘŀƴƎŜ Ψ5ƻ bƻǘ DŜƴŜǊŀǘŜΩ ŦƭŀƎ ς This allows you to either start or stop a recurring work 

from regenerating itself. 

¶ Copy Work Order ς Makes a copy of the current work order fields for re-insertion. Note: Only 

the primary fields are copied. 

¶ Paste Work Order ς Pastes a previously copied work order over the currently selected one. 

GO TAB 

 

The following are the element found on the Go tab: 

¶ Mechanics Database ς Opens the Mechanics and Employee database (Lookup Screen). 

¶ Inventory Database ς Opens the Parts and Inventory database (Lookup Screen). 

¶ Assets Database ς Opens the Equipment and Assets database (Lookup Screen). 

¶ Planner ς Branches to the Work Orders Planner view. 

¶ Calendar ς Branches to the Work Orders Calendar (Outlook style) view. 

¶ PM Groups ς Manage PM Groups and their schedules. 

¶ Batch Actions ς Opens the Work Orders Batch Actions routines. 

¶ Budgets ς Create and manage work order related budgets. 
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¶ Email Composer ς Opens the built-in email writer/composer dialog. 

¶ Maintenance Documents ς Branches control to the Maintenance Documents (Management) 

database. 

FILTERS TAB 
 

 

The following are the elements found on the Filters tab: 

¶ Work Requests ς Filters the database to view only those records with a status of Work Request. 

¶ Paste Due ς Filters the database by all records with scheduled completion date prior to today. 

¶ Custom Filter ς Launches the Custom Filter Wizard dialog that allows specific criteria to be setup 

to filter the database by. See the Main Reports ς Filter Wizard section form more information. 

¶ Default Filter ς Removes custom filter and reapplies the default filter. 

¶ Show All Works Orders ς Removes all filters and returns every work order in the system. 

¶ Open All Dates ς Shows all work orders that have yet to be completed or closed. 

¶ On-Hold ς CƛƭǘŜǊǎ ǘƘŜ ŘŀǘŀōŀǎŜ ǘƻ ǎƘƻǿ ŀƭƭ ǿƻǊƪ ƻǊŘŜǊǎ ǿƛǘƘ ŀ ǎǘŀǘǳǎ ƻŦ Ψƻƴ-ƘƻƭŘΩΣ ƻǊ ǿŀƛǘƛƴƎ ŦƻǊ 

some action to occur. 

¶ Set to Regenerate ς Shows all recurring types of work orders that have not regenerated, and do 

ƴƻǘ ƘŀǾŜ ǘƘŜ Ψ5ƻ bƻǘ wŜƎŜƴŜǊŀǘŜΩ ŦƭŀƎ ǎŜǘΦ 

¶ With Current Description ς This is based on the subject field of the currently selected work 

order. 

o Show All Records ς Shows all work orders with the current subject text. 

o Open Records Only ς Shows all work orders with the current subject that still have an 

open status. 

o Closed Records Only ς Shows all work orders with the current subject, and have a status 

of Completed. 

o Set to Regenerate ς Shows all work orders with the current subject and do not have the 

Ψ5ƻ bƻǘ wŜƎŜƴŜǊŀǘŜΩ ŦƭŀƎ ǎŜǘΦ 

¶ Assignments 

o Mechanics ς Filters the database by a selectable, assigned mechanic or employee.    

o Assets/Machines ς Filters the database by a single, selectable, assigned machine or 

asset. 

o Mechanics ς Filters the database by a selectable, assigned mechanic or employee.   

o Classifications ς Filters the database by a selectable, assigned classification.     

o Location ς Filters the database by a selectable, assigned location. 
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INSTRUCTIONS TAB   

 

The following are the elements found on the Instructions tab: 

¶ Safety Instructions ς Allows for the creation and editing of the Safety Instructions database. 

¶ Recurring (PM) Instructions ς Allows for the creation and editing of the reusable, recurring tasks 

Instructions database. 

¶ Work and Comments ς Allows for the creation and editing of the work to be done/comments 

instructions database. 

REPORTS TAB 

 

The following are the elements found on the Reports tab: 

¶ Main Summary ς This report uses a Wizard that allows the user to setup the criteria to use for 

the report creation. 

¶ Current W.O. (Current Work Order) 

o Work Order Details ς This report returns information on the currently selected work 

order, and can also be considered a status report. 

o Parts Inventory ς This reports on the inventory levels as they relate to items needed for 

the work order completion. 

o Estimated Costs ς This report returns information to the estimated costs associated 

with the currently selected work order. 

¶ Completed WOs (Completed Work Orders) 

o Work Orders Costs ς This report uses a criteria selection wizard to return costs 

information on work orders of your choice. Also includes a chart to help present the 

information returned. 

o Down Time Wizard - This report uses a criteria selection wizard to return costs 

information on work orders of your choice. Also includes a chart to help present the 

information returned. 
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o Completion Analysis ς Using a date range, this report returns information on the 

percentage of work orders that were completed on-time, late, etc. Also includes a chart 

to help represent the information returned. 

o Repair Codes ς This reports on a single asset and one or all associated repair codes. 

¶ Summary Reports 

o Equipment Summary ς This report uses a criteria selection wizard to return a summary 

of costs and downtime information. Also includes a chart to help present the 

information returned. 

o Completion Summaryς This report uses a criteria selection wizard to return a summary 

of costs, labor and downtime information.  

¶ Labor Resources 

o Open by Mechanic ς This reports on all open work orders assigned to a single mechanic. 

o Closed by Mechanic ς This reports on completed work orders for a date range and 

assigned to a single mechanic. 

o Overdue by Mechanics ς This reports on all overdue work orders assigned to a single 

mechanic. 

¶ Labor Time 

o Projected Man Hours ς This reports on work orders projected time needed based on a 

date range, asset and/or mechanic. 

o Actual Man Hours ς This reports on work orders actual time used based on a date 

range, asset and/or mechanic. 

o Time Card Report ς This reports on information as collected with the Time Tracker 

feature. 

¶ Open WOs (Open Work Orders) 

o Open by Primary Asset - This reports on all open work orders assigned to a single asset. 

o Projected Costsς This report uses a criteria selection wizard to return a summary of 

projected costs by category (labor, parts, etc.). 

o Past Due Work Orders ς Reports on all work orders that have a scheduled completion 

ŜŀǊƭƛŜǊ ǘƘŀƴ ǘƻŘŀȅΩǎ ŘŀǘŜ ŀƴŘ ƘŀǾŜ ŀ ǎǘŀǘǳǎ ƻŦ ƻǇŜƴΦ 

o Open Work Requests ς Reports on all work orders with a status of Work Request. 

Features of the Main Scheduler  
There are many features of the main scheduler, with the majority of these features found on either the 

tabbed pages found here, or within the tabbed ribbon control. We are going to explain the use of these 

features as we move through the tabbed pages. 
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Lookup Tab  
This tab helps in locating work orders by grouping, filtering and sorting them. All the work orders in the 

current filter are located in the grid found here. To select a work order and make it the active record, 

the user needs only to click on the work order from within the grid. Once selected the user can click on 

the other tabs to view or edit the work order itself. Also note that double clicking on a work order will 

move you to the Details tab showing the selected record. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Pay special attention to the following: 

¶ Using the Lookup Grids 

¶ Searching 

¶ Scanned Lookups (Barcodes Support) 
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Details Tab  
Under the Details tab you can setup your scheduling information, equipment, classification assignments, 

labor resources and other task specifics. 

 

Work Order Identification  
This section allows you to specify a subject for your work order, a task ID, and the location to be used in 

the execution of the work order. 

The following image illustrates the elements of the section: 

 

Subject 
This field can contain up to 100 alpha/numeric characters. Used for identification purposes, this should 

provide a brief description of the work order as it relates to the work to be performed. 
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Task ID 
This field can contain up to 20 alpha/numeric characters and is normally created for you by the 

application.  It uses the following format: YYMM-###, where YY is the year of work order creation, MM 

for the month of creation, and ### a sequential number. 

If wanted, this field can be overwritten, but this is not advised. Also having a unique ID is not enforced. 

However, to verify that it is unique you can click on the Check button adjacent to this field. 

Location  
This field can contain up to 50 alpha/numeric characters and is used to describe the physical location of 

where this work order is to be performed. 

Work Order Scheduling  
This area sets up the work order scheduling criteria. This section needs not to be filled in manually when 

the work order has been assigned to a PM group. 

The following image illustrates the elements of this section: 

 

Created 
This is set to the date the work order was created, either by the user or automatically by the program as 

in the case of recurring work order types. 

Start Date and Time  
These values would indicate the Scheduled date and time you would like work to commence on the 

work order. 

To set these values: 

¶ Click on the down arrows attached to these fields. 

¶ Click the value you want to use from the drop down list. 

End Date and Time 
These values would indicate the Scheduled date and time you would like work to be completed by. 

To set these values: 
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¶ Click on the down arrows attached to these fields. 

¶ Click the value you want to use from the drop down list. 

Work Order Recurrence  
The information in this area needs to setup when the current work order is assigned as one of the 

available recurring types, such as a recurring PM for example. 

Note:  Like the Scheduling section, this information does not require manual setup if the work order has 

been assigned to a PM group. 

The following image illustrates the elements of this section: 

 

Frequency  
This Frequency field allows you to specify the frequency at which the recurring work order will recreate 

(regenerate) itself. 

To setup the Frequency: 

¶ Click on the down arrow attached to this field. 

¶ Click on the value you want to assign from those listed. 

Available values are: 

¶ None 
¶ Every XX Meters (*see note below) 
¶ Every XX Days 
¶ XX Days (Mon-Fri)  
¶ Daily 
¶ Daily (Mon-Fri)  
¶ Weekly 
¶ Bi-Weekly 
¶ Every XX Weeks 
¶ Monthly 
¶ Bi-Monthly 
¶ Every XX Months 
¶ Quarterly 
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¶ Semi-Annually 
¶ Annually 
¶ Every XX Years 

 
*Please refer to the section ΨScheduling by MetersΩ for more information when theΩ Every XX MetersΩ 

frequency is assigned.  

XX Criteria  
If the selected Frequency has XX anywhere in its description, the XX Criteria value must also be 

provided. This field only accepts numeric values. 

To assign the XX Criteria value, please do one of the following: 

¶ Click the up arrow to increase the value here. 

¶ Click the down arrow to decrease the value here. 

¶ Click and type in your value in the space provided. 

The value entered here replaces the ΨXXΩ criteria of the selected frequency. For example, if you have a 

CǊŜǉǳŜƴŎȅ ƻŦ Ψ9ǾŜǊȅ ·· aŜǘŜǊǎΩ ǎŜƭŜŎǘŜŘΣ ŀƴŘ ȅƻǳ ŜƴǘŜǊ ΨолллΩ ŦƻǊ ǘƘŜ XX Criteria, the work order would 

ǊŜƎŜƴŜǊŀǘŜ Ψ9ǾŜǊȅ оллл aŜǘŜǊǎΩΦ 

Generate New When Done 
When this value is set, the program will not generate a new work order until the current work order is 

marked as completed. 

To set the Generate New When Done flag: 

¶ Place a checkmark in the Generate New When Done checkbox. 

Note about using this option: When this option is used, the selected recurring frequency value will be 

ŀŘŘŜŘ ǘƻ ǘƘŜ ǿƻǊƪ ƻǊŘŜǊΩǎ completion date. For an example: If you have a recurring frequency set for 

Ψ9ǾŜǊȅ мл 5ŀȅǎΩΣ ŀƴŘ ǘƘŜ ǿƻǊƪ ƻǊŘŜǊ Ƙŀǎ ŀ ŎƻƳǇƭŜǘƛƻƴ ŘŀǘŜ ƻŦ ǘƘŜ млǘƘ ƻŦ ǘƘŜ ƳƻƴǘƘΣ ǘƘŜ ƴŜǿƭȅ 

generated work order would have a scheduled start date of the 20th (Completion Date + 10). 

Using the example above, and the Generate New When Done is not used, the newly generated work 

order would have a scheduled start date of мл Řŀȅǎ ƛƴ ǘƘŜ ŦǳǘǳǊŜ ƻŦ ǘƘŜ ŎǳǊǊŜƴǘ ǿƻǊƪ ƻǊŘŜǊΩǎ Ψscheduled 

start dateΩ (not the completion date), regardless if the current work order is completed or not.  

Do Not Regenerate 
For recurring types of work order, setting this value will prevent the program from regenerating the 

work order at the set frequency. Also be aware that as the program executes one of the built-in 

regeneration routines, it will automatically set this flag. This basically does two things: 

¶ It tells the application and the user that the work order has already regenerated itself and a new 

one should already be present in the database. 
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¶ Lǘ ǇǊŜǾŜƴǘǎ ǘƘŜ ǇǊƻƎǊŀƳ ŦǊƻƳ ǊŜƎŜƴŜǊŀǘƛƴƎ ǘƘŜ ΨǎŀƳŜΩ ǿƻǊƪ ƻǊŘŜǊ ŀƎŀƛƴΦ ¢ƘŜǊŜōȅ ǇǊŜǾŜƴǘƛƴƎ 

possible duplicates from being created. 

To manually change the Do Not Regenerate value (Allowed but not recommended): 

¶ Move to the Work Orders tab in the ribbon. 

¶ Click on the Recur option to expand the drop down. 

¶ Click /ƘŀƴƎŜ Ψ5ƻ bƻǘ wŜƎŜƴŜǊŀǘŜΩ ŦƭŀƎ. 

¶ Click Yes to the prompt. 

Work Order Settings  
The section allows you to setup the Task Type of the work order, the priority indicator, and the 

estimated downtime. 

The following image illustrates the elements of the section: 

 

Task Type (Work Order Type Assignment)  
There are 12 possible task types available, with 10 of these having user definable titles. Five of these 

task types are designated as recurring types of work orders, where the others are designated as repair, 

or one-time work orders types. See the Work Orders Setup section in this chapter for more information.  

To assign a Task Type to your work order: 

¶ Click on the down arrow attached to this field. 

¶ Click on the value you want to assign from those listed. 

Note that the top 5 task types listed are recurring types, with the remaining types being one-time or 

repair types. 

Priority  
You can assign your work orders a priority indicator. Options include: Urgent, High, Normal and Low. 

To assign a Priority to your work order: 

¶ Click on the down arrow attached to this field. 

¶ Click on the value you want to assign from those listed. 
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Estimated Down Time  
You can record the estimated time you feel will be needed to completed a work order. This information 

shows on the work order itself, and can be used with reports. 

To assign the Estimated Down Time for your work order: 

¶ Click on the down arrows adjacent to the HRS and MINS fields. 

¶ Click on the value you want to assign from those listed. 

Assigned Assets 
You can assign an unlimited number of assets to a work order. However, only one of these will be used 

as the Primary Asset. Most of the available reports will be based on the Primary assignment. 

The following image illustrates the elements of this section: 

 

To assign an asset to the work order:  

¶ Move to the Assigned Assets section and click on the + (plus sign) in the data control found 

there. 

¶ From the invoked lookup dialog, click on the asset record you want to assign. 

¶ Click on the Select button. 

¶ Click the Post (check) ōǳǘǘƻƴ ƛƴ ǘƘŜ !ǎǎŜǘǎΩ Řŀǘŀ ŎƻƴǘǊƻƭΦ 

To set which asset to assign as the primary asset:  

¶ Select the asset you want to assign from those listed in the grid. 

¶ Click the Set Primary Asset button.  

¶ Click Yes to the prompt about setting the primary asset. 

¶ The asset should be displayed in the Primary Asset field. 

To remove an asset from the current work order:  

¶ Click on the asset you want to remove from those listed. 

¶ Click on Remove (minus sign) button in the !ǎǎŜǘǎΩ Řŀǘŀ ŎƻƴǘǊƻƭΦ 
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¶ When prompted about the removable, click on the Yes button. 

¶ Click the Post (check) ōǳǘǘƻƴ ƛƴ ǘƘŜ !ǎǎŜǘǎΩ Řŀǘŀ ŎƻƴǘǊƻƭΦ 

To use the Auto Subject feature in this section:  

¶ Click on the Auto Subject button found in this area. 

¶ When prompted about accepting this new Subject title, click OK. 

The auto subject feature combines the assigned work type with information about the assigned primary 

asset to create a Subject title for the current work order, replacing any existing title. 

Primary Work Assignments  
The Primary Work Assignments section allows you to assign 3 employees or mechanics, and one 

Manager to the current work order. These resources will be shown on the printed document, and also 

used with the Auto Email of work orders. 

The following image illustrates the elements of this section: 

 

To assign mechanics or employees to the work order: 

¶ Move to and click on the Select button adjacent to the Assignment field you want to assign an 

employee to. 

¶ From the invoked lookup dialog select the record you want to assign from those displayed. 

¶ Click on the Select button. 

¶ Repeat the above steps for each assignment you want to make, including the Manager field. 

Options Tab  
The Options tab allows you to continue making general assignments to the current work order. Some of 

the possible assignments are vendors and contractor, auto email features, email list, add attachments 

and more. 
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General Assignments  
This section allows you make some general type assignment to your work order. These assignments help 

with the creation of reports. 

The following image illustrates the elements of this section: 

 

To make the assignments in this section: 

¶ Move to the appropriate field and click on the down arrow on the drop down list. 

¶ Make your selection by clicking on it. 

Work Order Auto Email  
The application has the ability to automatically email copies of work orders as they become due. 

However, for a work order to be able to use this feature, the feature needs to be enabled. 

The following image illustrates the elements of this section: 

 

Use Auto Email 
To give the application permission to use the Auto Email feature for the current work order: 

¶ Place a checkmark in the Use Auto Email checkbox. 

When the application sends out an email of the work order, the application sets an Email Send flag, 

preventing the application from sending out duplicate emails of the same work order.  

Prevent Auto Email for the Work Order  

To override the email sent flag, allowing an additional set of emails to be sent: 

¶ Remove the checkmark from the Prevent Auto Email for this Work Order check box. 
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Work Order Audits  
With Work Order Audits you can attach an audit list to the end of work orders. These audits can be a 

requirement made by company policy, a federal requirement or from customers. Possible audit items 

could be a check list to see if any tools were left in the work area, was welding performed, was the area 

inspected and so on. 

The following image illustrates the elements of this section: 

 

Select Group 
To assign an Audit Group to the current work order: 

¶ Click on the Select Group button. 

¶ From the invoked Audit Setup dialog, move to the Audit Groups grid and select the audit group 

you want to assign. 

¶ Click on the Select button. 

Creating Audit Lists  
Audit lists require a few steps. A group is first created, and then audit items are added to this group.  

Please note that if you later add items to audit groups, these new audit items may also show up on 

previously closed items. 
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Creating Audit Lists  
To create an audit list: 

 

¶ Move to the Options tab in the Maintenance Scheduler module. 

¶ Move the Work Order Audits section and click on the Select Group button. 

¶ Move to the data control located below the Audit Groups grid and click on the Append (+) 

button. 

¶ From the invoked New Audit Group dialog, move to the space provided and type in a title for 

the new group. This field can contain alpha/numeric characters with a maximum length of 40 

characters. 

¶ Click the OK button. 

Adding Audit Items  
To add Audit Items to an Audit Group: 
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¶ Move to the Audit Groups grid and click on the audit group you want to add items to. 

¶ Move to the data control located below the Audit Questions grid and click on the Append (+) 

button. 

¶ From the invoked New Audit Question dialog, move to the space provided and type in your new 

audit question. These are no size limit to this field, but you should try and keep it to a minimum. 

¶ Click on the OK button. 

¶ Repeat the above steps to add additional audit items. 

Performing a Work Order Audit  
If a work order has an Audit Group assigned to, it may be required that the audit be completed. 

 






































































































































































































































































































































































































































































































